


 

 

SAFETY PRECAUTIONS 
To prevent accidents or personal injuries, please be sure to comply with the following items. 

Prior to installation, operation, maintenance and check, please read this manual carefully for proper use. 
Before using, please fully understand the knowledge related to the equipment, safety precautions and all 

other precautions. 
Safety precautions are divided into two levels in this manual: Warning and Caution. 

WARNING Incorrect operation may lead to death or serious injury.

● Take appropriate safety measures to the external circuit of the product to ensure the security of 

the whole system in case of abnormalities caused by product failure or external. 

● Do not use this product in areas with inflammable gases. 

Otherwise it may lead to an explosion. 

● Do not put this product into a fire. 

Otherwise it could cause damage to the battery or other electronic parts. 

● Do not impact, charge or heat the lithium battery, and do not put it into a fire. 

Otherwise it may lead to fire or damage. 

CAUTION
 

Incorrect operation may lead to injury or material loss. 

● To prevent the excessive exothermic heat or smoke generation of the product, a certain margin is 

required for guaranteed characteristics and performance ratings of relative products. 

● Do not decompose or transform it. 

Otherwise it will lead to the excessive exothermic heat or smoke generation of the product. 

● Do not touch terminal blocks during power-on. 

Otherwise it may result in an electric shock. 

● Set an emergency stop and interlock circuit in the external devices. 

● Connect wires and connectors reliably. 

Otherwise it may lead to the excessive exothermic heat or smoke generation of the product. 

● Do not undertake construction (such as connection and disconnection) while the power supply is on.  

It could lead to an electric shock. 

● If the equipment is used in a manner not specified by the Panasonic, the protection provided by the 

equipment may be impaired. 

● This product has been developed/produced for industrial use only. 

 
Description on Copyright and Trademarks 

● The copyright of this manual is owned by Panasonic Industrial Devices SUNX Co., Ltd. 

● Unauthorized reproduction of this manual is strictly prohibited. 

● Windows is a registered trademark of Microsoft Corporation in the U.S. and other countries. 

● Ethernet is a registered trademark of Fuji Xerox Co., Ltd. and Xerox Corporation. 

● EtherNet/IP is a registered trademark of ODVA (Open DeviceNet Vendor Association). 

● SDHC and SD logos are trademarks of LLC. 

● Other company and product names are trademarks or registered trademarks of their respective companies. 
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Introduction 

Thank you for buying a Panasonic product. Before you use the product, please carefully read 
the users manual, and understand their contents in detail to use the product properly. 

Types of Manual 

• This manual describes the "positioning function (table setting mode) / PWM output and high-
speed counter function" implemented in FP0H Control Unit. 

• There are different types of users manual for the FP0H series. Please refer to a relevant 
manual for the unit and purpose of your use. 

• The manuals can be downloaded on our website:  
http://industrial.panasonic.com/ac/e/dl_center/manual/ 

Unit name or purpose of 
use 

Manual name Manual code 

FP0H Control Unit 
FP0H User’s Manual (Basic) WUME-FP0H-BAS 

FP series Programming Manual ARCT1F313E 

 Positioning 
Function/PWM 
Output/High-speed 
Counter Function 

FP0H User’s Manual 
(Positioning/PWM Output/High-speed Counter) WUME-FP0HPOS 

 

 Serial Communication 
Function FP0H User’s Manual (COM Communication) WUME-FP0HCOM 

 Ethernet Communication 
Function FP0H User’s Manual (Ethernet Communication) WUME-FP0HET 

 EtherNet/IP 
Communication Function FP0H User’s Manual (EtherNet/IP) WUME-FP0HEIP 

 Logging/Trace Function FP0H User’s Manual (Logging/Trace Function) WUME-FP0HLOG 

FP0H Extension 
(Communication) Cassette FP0H User’s Manual (COM Communication) WUME-FP0HCOM 

FP0H Positioning Unit FPΣ Positioning Unit User’s Manual (Note) ARCT1F365E 

(Note): For information on FP0H Positioning Unit, refer to the conventional FPΣ Positioning Unit Manual. The color of 
the main unit case is different (FP0H is black, and FPΣ is gray), however, the other specifications are the 
same. 

. 
 

 

http://industrial.panasonic.com/ac/e/dl_center/manual/
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1.1 Functions of Unit 

1.1.1 Overview of FP0H Positioning Function 

 Up to 4-axis position control is available by combining with a driver of pulse string 
input type. 

• The pulse output can be performed up to 100 kHz, and servo motors can be controller. 

• It is also available for a stepping motor connected by open collector output. 

 

 Programs can be simplified by adopting the table setting mode. 
• The dedicated software "Configurator PMX" is available, which allows ease of setting a 

variety of parameters and positioning  tables required for positioning control. "Configurator 
PMX" is started from the "Options" menu of tool software "FPWIN GR7". 

• In user programs, positioning control is executed only by specifying axis numbers (channel 
numbers) and table numbers, and executing instructions. 

 

 Four kinds of position control patterns (Table setting mode) 
• Four patterns, which are E-point control (first speed automatic trapezoidal 

acceleration/deceleration), P-point control (second speed automatic trapezoidal 
acceleration/deceleration), C-point control (continuance point control) and J-point control 
(from speed control to position control), can be selected. They are created as tables on 
"Configurator PMX". 

 Five kinds of home return operations are supported. (Table setting mode) 
• Five kinds of home return methods including home search are available. The most 

appropriate home return method can be selected in accordance with the system such as 
home input, near home input and the type of driver. 

 FPΣ compatible instruction mode is also available. 
• The mode which uses instructions similar to those for the existing FPΣ series models (F171 

to F175, F0 and F1). 
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1.1.2 Unit Type and Available Functions 

Available conditions vary by functions. 

 Comparison of functions and performances 
Item Specifications 

High-speed 
counter 

Single-phase 
Max. 4 channels (CH0-3) 
Max. 100 kHz×4 

2-phase 
Max. 2 channels (CH0, CH2) 
Max. 50kHz×2 

Pulse output 
Independent Max. 4 axes (CH0-3), Max. 100 kHz 

Interpolation Max. 2 axes (CH0, CH2), Max. 100 kHz (Composite speed) 

PWM output Max. 4 points (CH0-3) 

(Note 1): Functions, channel numbers and I/O numbers used are set in the tool software. 
(Note 2): I/O numbers used for each function should be allocated so that they do not overlap. 
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1.2 Restrictions on Combinations and Functions 

1.2.1 Applicable Versions of Unit and Software 

For using FP0H, the software of the following versions is necessary. 

Item Applicable versions 
Programming Tool Software 
FPWIN GR7 FPWIN GR7  Ver.2.18 or later 

Configurator PMX It is used for using the pulse output function in the table setting mode. It is 
implemented in FPWIN GR7/Pro7 and activated from the option menu. 

(Note 1): The latest version is provided free of charge at our website 
http://industrial.panasonic.com/ac/e/dl_center/software/  Use the latest version. 

(Note 2): It is also necessary to install a setup file for using FP0H with FPWIN Pro7. For details, see the above 
website. 

1.2.2 Restrictions on I/O Allocation 

• I/O signals used for each function are set in the tool software. They are allocated 
automatically when set by Configurator PMX. 

• Allocate the I/O numbers used for the pulse output function, high-speed counter function and 
PWM function so that they do not overlap. 

 Examples of unusable combinations 
Example When using the output Y0 as CH0 for the pulse output function. the PWM output CH0 cannot be 

used. 

 

http://industrial.panasonic.com/ac/e/dl_center/software/
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 Input signals of Control Unit 

I/O 
no. Pulse output function 

High-speed counter function 
Count input 

Reset input 
Single-phase 2-phase 

X0: CH0 J-point positioning start 
input  CH0 Count input 

CH0 Count input 
-  

X1 CH1 J-point positioning start 
input CH1 Count input -  

X2 CH0 Home input  -  -  CH0, CH1 Reset input 

X3 CH2 J-point positioning start 
input CH2 Count input 

CH2 Count input 
-  

X4 CH3 J-point positioning start 
input CH3 Count input -  

X5 CH1 Home input -  -  CH2, CH3 Reset input 

X6 CH2 Home input -  -  -  
X7 CH3 Home input -  -  -  

(Note 1): When the reset input settings of reset input for the single-phase input overlap at CH0 and CH1 or CH2 and 
CH3, the setting of CH0 or CH2 has priority. 

 

 Output signals of Control Unit 
I/O 
no. 

Pulse output function 
PWM output 

Pulse output Deviation counter clear 
Y0 CH0 CW or pulse output  -  CH0  
Y1 CH0 CCW or sign output  -  (Note 2)  
Y2 -  CH0  -  
Y3 CH1 CW or pulse output  -  CH1  
Y4 CH1 CCW or sign output  -  (Note 2) 
Y5 -  CH1 -  
Y6 - - - 
Y7 - -  - 
Y8 CH2 CW or pulse output  -  CH2  
Y9 CH2 CCW or sign output  -  (Note 2) 
YA - CH2  -  
YB CH2 CW or pulse output  -  CH3  
YC CH2 CCW or sign output  -  (Note 2) 
YD - CH3  -  
YE - -  -  
YF - -  -  

(Note 2): When using the PWM output, the output numbers to be paired are normal output.  
(Note 3): When using the target value match ON instruction (F166) or target value match OFF instruction (F167) in 

the high-speed counter function, arbitrary output is specified in the range of Y0 to Y1F in a user program so 
that it does not overlap the above functions. 
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1.3 Comparison of Pulse Output Function 

1.3.1 Types of Positioning Control Modes 

For using the FP0H pulse output function, the following two control modes are available. 

 Table setting mode 
• Positioning parameters such as position command and speed command are created as data 

tables by tool software Configurator PMX  in advance. 

• As parameters are set in advance, programs can be simplified. 

• Four patterns of position control modes and five patterns of home return modes are available. 

• Dedicated instructions F380 to F385 are used for the control. 

• Set positioning parameters and information on positioning tables can be exported as a setup 
file of Configurator PMX and reused between multiple units and projects. 

 FPΣ compatible instruction mode 
• Positioning parameters such as position command and speed command are set as 

operands of instructions. 

• Dedicated instructions F171 to F175 and instructions F0 to F1 are used for the control. 

• This method is similar to the pulse output function of the existing model FPΣ. 

 Selection of positioning control mode 
• The positioning control mode is selected in the system register no. 407 by the tool software. 
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1.3.2 Comparison of Two Control Modes 

There are following differences between the table setting mode and FPΣ compatible 
instruction mode. 

 Comparison of Two Control modes 
Item Table setting mode FPΣ compatible instruction mode 

Stop control 

Type Four patterns (System stop, Emergency 
stop, Limit stop, and Deceleration stop) Emergency stop only 

Start Turns on the output contact allocated to 
each axis for each stop method. 

Turns on the bit 3 of the special data 
register DT90052 using F0 instruction in a 
user program. 

JOG 
operation 

Set Set in the positioning parameters of 
Configurator PMX. Set using the operands of instructions. 

Start F381 instruction F172 instruction 

Home return 

Type Five patterns (DOG methods x 3, Home 
position method x 1, Data set method x 1) 

Twp patterns (DOG methods x 1, Home 
position method x 1) 

Set Set in the positioning parameters of 
Configurator PMX. Set using the operands of instructions. 

Start F382 instruction F171 instruction 

Positioning 
operation 

Type 
Four patterns (E-point control, P-point 
control, C-point control and J-point 
control) 

E-point control (First speed 
acceleration/deceleration), Multistep 
acceleration/deceleration control 

Set Set in the positioning data table of 
Configurator PMX. Set using the operands of instructions. 

Start F380 instruction F171 instruction 

Positioning 
operation 
interpolation 

Type Three patterns (E-point control, P-point 
control, C-point control) 

E-point control (First speed 
acceleration/deceleration) 

Set Set in the positioning data table of 
Configurator PMX. Set using the operands of instructions. 

Start F380 instruction F175 instruction 

Others 

Dwell time setting, Repeat control 
(Positioning parameter setting) 
Multiple table simultaneous start (F383 
instruction) 

Data table control (F174 instruction) 

 

 Comparison in programming 
Item Table setting mode FPΣ compatible instruction mode 

Read/Write 
of elapsed 
value 

Area Positioning memory Special data registers DT90348 to 
DT90361 

Execute F384 instruction (Read), F385 
instruction (Write) F1 instruction (Both Read and Write) 

Confirmation of BUSY 
state Input contacts X808 to X80B Special relays R911C to R911F 

Confirmation of 
positioning completion Input contacts X810 to X813 

Instead detects the fall of the above 
BUSY signal by a user program.  Confirmation of home 

return completion Input contacts X828 to X82B 

Near home input 
Allocate arbitrary input contacts and 
turn on the outputs Y850 to Y853 by 
user programs. 

Allocate arbitrary input contacts and turn 
on the bit 4 of the special data register 
DT90052 by user programs. 
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2.1 Connections with Servo Motor Amplifier 

2.1.1 Connection Example 

 
(Note): The allocation of I/O numbers on the controller side depends on channel numbers. 
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2.1.2 Precautions on Connection 

 Connections of various signals 
Signal type Point 

Pulse command output 

 Connect the output allocated to each channel and the command pulse input of 
servo amplifier. 

 Connect a resistor (2 kΩ) for limiting currents. 
 Use twisted-pair cables for the connection. 

Home input 
 Connect the input allocated to each channel and the Z phase input of servo 
amplifier. 
 Use twisted-pair cables for the connection. 

Near home input 
 Connect the near home sensor to an arbitrary input. 
 It will be valid when the outputs (Y850 to Y853) allocated to each channel in user 
programs turn ON. 

CCW over limit input  Connect the over limit switches to arbitrary inputs. 
 It will be valid when the outputs (Y860 to Y867) allocated to each channel in user 
programs turn ON. CW over limit input 

Deviation counter clear 
output 

 Connect the output allocated to each channel and the counter clear input of servo 
amplifier. 
 The length of a deviation counter clear signal is specified in the range of 1 to 100 
ms in the “Parameter setting” dialog box of Configurator PMX. 

Servo on output  Connect an arbitrary output of PLC to the servo on input of servo amplifier. 

 

KEY POINTS
 

• Use twisted-pair cables for the connection between the unit and servo 
amplifiers. 
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2.2 Connection with Stepping Motor Driver 

2.2.1 Precautions on Connection 

 Connections of various signals 
Signal type Point 

Pulse command output 

 Connect the output allocated to each channel and the command pulse input of 
motor driver. 
 Use twisted-pair cables for the connection. 
 Use a 24 VDC input for the input on the driver side. When the input interface of the 
driver is 5 VDC input, insert a resistor for limiting currents externally. 

Home input 
 Connect the input allocated to each channel and the home sensor. 
 Use twisted-pair cables for the connection. 

Near home input 
 Connect the near home sensor to an arbitrary input. 
 It will be valid when the outputs (Y850 to Y853) allocated to each channel in user 
programs turn ON. 

CCW over limit input  Connect the over limit switches to arbitrary inputs. 
 It will be valid when the outputs (Y860 to Y867) allocated to each channel in user 
programs turn ON. CW over limit input 

 

KEY POINTS
 

• Use twisted-pair cables for the connection between the unit and motor 
driver. 
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3.1 Safety Circuit Design 

System configuration example 
Installation of the over limit switch 

  

 Confirmation of safety circuit 
Number Item Description 

① Safety circuit based on 
external circuit 

Install the safety circuit recommended by the manufacturer of the 
motor being used. 

② Safety circuit based on the 
unit 

Install over limit switches as shown above. 
Connect the over limit switches on the (+) and (-) sides to the input 
circuit of PLC. 
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3.2 Before Turning On the Power 

System configuration example 

 
 

 Items to check before turning on the power 
Number Item Description 

① Checking connections to 
the various devices 

Check to make sure the various devices have been connected as 
indicated by the design. 

② Checking the installation of 
the external safety circuit 

Check to make sure the safety circuit (wiring and installation of over 
limit switch) based on an external circuit has been installed securely. 

③ 
Checking the installation of 
the safety circuit based on 
the unit 

Check the connection between the unit and over limit switches. 
Check the installation condition of the over limit switches. 

④ 
Checking the procedure 
settings for turning ON the 
power supplies 

Make sure settings have been entered so that power supplies will be 
turned on according to the procedure outlined in section “Procedure 
for Turning On the Power”. 

⑤ Checking the CPU mode 
selection switch 

Set the CPU unit to PROG. mode. Setting it in the RUN mode can 
cause inadvertent operation. 
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3.3 Procedure for Turning On the Power 

3.3.1 Procedure for Turning On the Power 

When turning on the power to the system incorporating the unit, consider the nature and 
states of any external devices connected to the system, and take sufficient care so that 
turning on the power will not initiate unexpected movements. 

Sequence 
1. Turn on the power supplies for the input and output devices connected to the PLC. 

2. Turn ON the power supply for the PLC. 

3. Turn ON the power supply for the motor driver. 

3.3.2 Procedure for Turning Off the Power 

Sequence 
1. Check to make sure the rotation of the motor has stopped, and then turn OFF the power 

supply for the motor driver. 

2. Turn off the power supply for the PLC. 

3. Turn off the power supplies for the input and output devices connected to the PLC. 
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3.4 Confirming while the Power is ON 

3.4.1 Items to check after turning on the power 

System configuration example 
Check each item in the following four major steps. 

 

 Items to check before turning on the power 
Number Item Description 

① Checking the installation of 
the external safety circuit 

Check to make sure the safety circuit (wiring and installation of over 
limit switch) based on an external circuit has been installed securely. 

② Checking the safety circuit 
by the PLC unit 

Check the connection between the unit and over limit switches. 
Check the installation condition of the over limit switches. 

③ Checking the near home 
input and home input 

Check if the near home input and home are loaded as the inputs of 
the PLC and activated properly by performing JOG operation or 
home return operation. 

④ 
Checking the rotation, 
moving direction, and 
moving distance. 

Check the rotation, moving direction and moving distance by 
performing JOG operation or positioning operation. 
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3.4.2 Checking the installation of the external safety circuit 

Make a check on the safety circuit recommended by the motor manufacturer, which includes a 
check on the disconnection of the power supply to the motor driver with CW and CCW drive 
inhibition switch input from an external circuit. 

3.4.3 Checking the safety circuit based on the unit 

Procedure 1 
Using forced operation of the over limit switch, check to see if the over limit input is being 
properly taken into the PLC side. 

Procedure 2 
If necessary, input a program to start the JOG operation. Then operate the over limit input to 
check whether the motor will stop. The limit stop will be effective when output signals (Y860 to 
Y867) allocated to each axis turn ON in user programs. The valid logic of limit input can be 
changed in the parameter setting menu of "Configurator PMX". 

Procedure 3 
Using the JOG operation, check to see if the over limit switch is functioning properly. 

 Operation at limit input 
Conditions Direction Limit status Operation 

When JOG operation is 
started 

Forward 
Over limit input (+): ON Not executable, Error occurs. 

Over limit input (-): ON Executable 

Reverse 
Over limit input (+): ON Executable 

Over limit input (-): ON Not executable, Error occurs. 

During JOG operation 

Forward 
Over limit input (+): ON Limit stops, Error occurs. 

Over limit input (-): ON Limit stops, Error occurs. 

Reverse 
Over limit input (+): ON Limit stops, Error occurs. 

Over limit input (-): ON Limit stops, Error occurs. 
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3.4.4 Checking the Operation of the Near Home Switch and Home Switch 

Procedure 1 
Check if the near home input is loaded as input signals on the PLC properly by operating the 
home input and near home input forcibly. 

Procedure 2 
Start the home return by inputting the home return program, and check if the operation 
transits to the deceleration operation by the near home input. 

Points to check 
Set the valid logic which enables the home input and near home input in the parameter setting 
menu of "Configurator PMX". 

Procedure 3 
Check if the home stop position shifts by repeating the JOG and home return operations. 

Points to check 
A shift may result depending on the position of near home input or home input and the return 
speed. 

Procedure 4 
If the home stopping position is shifted, change the position of near home input or reduce the 
home return speed. 

3.4.5 Checking Rotating and Moving Directions and Moving Distance 

Procedure 1 
Execute the JOG operation to confirm the rotating direction and moving direction of the motor. 

Points to check 
The rotating direction is determined according to the installation of the ball screw or the 
“CW/CCW direction setting” of the parameter. 

Procedure 2 
Check if the moving distance is that as designed by performing the JOG operation or 
positioning operation. 

Points to check 
The moving distance is determined according to the pitch of the ball screw, deceleration gear 
ratio or setting movement amount of the positioning data. 
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4.1 Confirming I/O Allocation 

4.1.1 When Using Pulse Output Table Setting Mode 

• The home input signal and positioning completion signal is allocated to I/O signals. 

 Allocation of I/O signals (Input) 

Signal name 
I/O number 

Axis 1 Axis 2 Axis 3 Axis 4 
CH0 CH1 CH2 CH3 

J-point control positioning start input X0 X1 X3 X4 

Home input (Note1) X2 X5 X6 X7 

Near home input (Note 1) (Note 2) (Y850) (Y851) (Y852) (Y853) 

Over limit input (+) (Note 2) (Y860) (Y862) (Y864) (Y866) 

Over limit input (-) (Note 2) (Y861) (Y863) (Y865) (Y867) 

BUSY X808 X809 X80A X80B 

Operation done X810 X811 X812 X813 

Home return done X828 X829 X82A X82B 

(Note 1): Even when setting the linear interpolation, the interpolation operation is not performed for the home return. 
Execute the operation for X axes and Y axes separately. 

(Note 2): The near home input , over limit input (+) and over limit input (-) will be valid when an arbitrary input is 
allocated and the output relay indicated in the above table turns ON. 

 Sample program 
The following sample shows the program when the near home input, over limit input (+) and 
over limit input (-) are allocated to XA to XC. 

XA Y850

XB Y860

XC Y861

 

KEY POINTS
 

• When selecting the table setting mode, the control active flags (R911C to 
R911F) are not activated. Confirm that other instructions for the table 
setting mode (F380 to F383) are not activated using the above BUSY flags 
(X808 to X80B), and execute each instruction. 
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 Allocation of I/O signals (Output) 

Signal name 
I/O number 

Axis 1 Axis 2 Axis 3 Axis 4 
CH0 CH1 CH2 CH3 

CW output or Pulse output Y0 Y3 Y8 YB 

CCW output or Sign output Y1 Y4 Y9 YC 

Deviation counter clear output Y2 Y5 YA YD 

System stop Y800 

Error clear request Y801 

Warning clear request Y802 

Emergency stop Y830 Y831 Y832 Y833 

Deceleration stop Y838 Y839 Y83A Y83B 

J point control speed change Y840 Y841 Y842 Y843 

Near home input  (Note 1) (Y850) (Y851) (Y852) (Y853) 

Over limit input (+) (Note 1) (Y860) (Y862) (Y864) (Y866) 

Over limit input (-) (Note 1) (Y861) (Y863) (Y865) (Y867) 

(Note 1): The near home input , over limit input (+) and over limit input (-) will be valid when an arbitrary input is 
allocated and the output relay indicated in the above table turns ON. 
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4.1.2 When Using Pulse Output Function (FPΣ Compatible Instruction Mode) 

• The following reserved areas are allocated to the home input and control active flag. 

• Arbitrary input are allocated to the near home input and pulse output stop signal (emergency 
stop). 

 Allocation of I/O signals (Input) 

Signal name 
I/O number 

Axis 1 Axis 2 Axis 3 Axis 4 
CH0 CH1 CH2 CH3 

Home input (Note1) X2 X5 X6 X7 

Near home input (Note 2) 

Control active flag (BUSY) R911C R911D R911E R911F 

Operation done 
(Note 3) 

Home return done 

(Note 1): Even when setting the linear interpolation, the interpolation operation is not performed for the home return. 
Execute the operation for X axes and Y axes separately. 

(Note 2): The near home input will be enabled by allocating an arbitrary input and turning on the bit 4 of the special 
data register DT90052 by the pulse output control instruction (F0). 

(Note 3): The falling edge (on to off) of the control flag (BUSY) after the execution of the pulse output instruction 
(F171) is used in place of the operation done flag or home return done flag. 

 Allocation of I/O signals (Output) 

Signal name 
I/O number 

Axis 1 Axis 2 Axis 3 Axis 4 
CH0 CH1 CH2 CH3 

CW output or Pulse output Y0 Y3 Y8 YB 

CCW output or Sign output Y1 Y4 Y9 YC 

Deviation counter clear output (Note 1) Y2 Y5 YA YD 

Emergency stop (Pulse output stop) (Note 2) 

(Note 1): Even when setting the linear interpolation, the interpolation operation is not performed for the home return. 
Execute the operation for X axes and Y axes separately. 

(Note 2): The emergency stop will be enabled by specifying channel numbers and turning on the bit 3 of the special 
data register DT90052 by the pulse output control instruction (F0). In case of the emergency stop in the FPΣ 
compatible instruction mode, pulses stop immediately. 
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 Allocation of I/O relating to pulse output control (Only in FPΣ compatible instruction 
mode) 

• By using the special data register DT90052 by the pulse output control instruction (F0), 
operations such as loading the near home input and stopping the pulse output forcibly can 
be performed. 

bit no.15 4 3     1 0

Software reset

0 0 0 1 0 0 0 0
8 7

0: Disable, 1: Enable

H1: Fixed

Count 0: Enable   1: Disable

Pulse output 0: Continue, 1: Stop

Near home 0: Invalid, 1: Valid

Channel specification
H0 to H3: CH0 to CH3

 

• When controlling the above functions using external inputs, arbitrary inputs can be allocated.  
The following program is for loading the near home input of CH1 using the input X10. 

X10
DT90052H1110F0 MV

DT90052H1100F0 MV

（ ）DF

 

KEY POINTS
 

• In the FPΣ compatible instruction mode, the allocations of J-point control 
and limit inputs are not available. 

• In the FPΣ compatible instruction mode, the allocations of system stop, 
error clear request, deceleration stop and J-point speed change are not 
available. 
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4.1.3 When Using PWM Output Function 

• The following reserved areas are allocated to the PWM output and control active flag. 

• Allocate them so that they do not overlap the I/O used for the pulse output function. 

 Allocation of I/O signals 

Signal name 
I/O number 

CH0 CH1 CH2 CH3 
PWM output Y0 Y3 Y8 YB 

Control active flag (BUSY) R911C R911D R911E R911F 

 

4.1.4 When Using High-speed Counter Function 

• The following reserved areas are allocated to the hardware reset input and control active flag. 

 Allocation of I/O signals (When using internal input) 

Signal name 
I/O number 

CH0 CH1 CH2 CH3 

Count input 
Single-phase input X0 X1 X3 X4 

2-phase input X0/X1 - X3/X4 - 

Hardware reset 
input 

Single-phase input X2 X2 X5 X5 

2-phase input X2 - X5 - 

Control active flag 
(BUSY) 

Single-phase input R9110 R9111 R9112 R9113 

2-phase input R9110 - R9112 - 

(Note 1): When the reset input settings of reset input for the single-phase input overlap at CH0 and CH1 or CH2 and 
CH3, the setting of CH0 or CH2 has priority. 



4.1 Confirming I/O Allocation 

 
4-7 

 Allocation of I/O relating to High-speed counter control 
• By using the special data register DT90052 by the high-speed counter control instruction 

(F0), operations such as the software reset of the high-speed counter and disabling/enabling 
the count can be performed. 

bit no.15 0
0 0 0 0 0 0 0 0

8 7

H00: Fixed

External reset input 0: Valid, 1: Invalid

High-speed counter 
instruction 0: Continue, 1: Cancel

Channel specification
H0 to H3: CH0 to CH3

Software reset 0: Disable, 1: Enable

Count 0: Enable   1: Disable

 

• When controlling the above functions using external inputs, arbitrary inputs can be allocated. 

The following program is for performing the software reset of CH0 using the input X7. 

X7
DT90052H1F0 MV

DT90052H0F0 MV

（ ）DF
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4.2 Settings in Configurator PMX 

4.2.1 Allocating Channels to be Used 

Use the Configurator PMX to allocate used channels and applications. The following 
procedure is explained on the condition that the FPWIN GR7 has already started. 

PROCEDURE  
1. Select “Options” > “Positioning Table Settings” from the menu bar. 

”Configurator PMX” will be activated. 

 
2. Select “Channel setting” > “Used channel setting” from the menu bar.  

The “Used channel setting” dialog box appears. 
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3. Select the axes to be used and the usage, and press the [OK] button. 

When the setting is changed, a confirmation message box appears. 

  
4. Confirm the change and press the [Yes] button. 

A data table tab each is created for the groups set. 

 
 

KEY POINTS
 

• When interpolation control is selected, the data table of the channel 
numbers of X and Y axes will be added, and [Interpolation] will be displayed 
on the tab. 

 

• When changing "Used channel setting" in Configurator PMX, the system 
registers no. 400 to 402 and 407 corresponding to the I/O used for the 
positioning control will be automatically updated. For details, refer to "4.3 
System Register Settings". 
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4.2.2 Setting Parameters 

Use the Configurator PMX to allocate the most fundamental parameters for positioning control, 
such as the motor rotation direction, pulse output method (CW/CCW and Pulse/Sign), home 
input, limit input logic, and positioning control. The following procedure is explained on the 
condition that the Configurator PMX has already started. 

PROCEDURE  
1. Select “Channel setting” > “Parameter settings” from the menu bar. 

The “Parameter settings” dialog box appears. 

 
2. Make necessary parameter settings according to the application and press 

the [OK] button. 

The settings will be stored as part of positioning parameter data. 
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 Parameters 

Parameter name Default 
(unit) Settings 

Basic 
Setup 

Pulse output method Pulse/Sign Pulse/Sign, CW/CCW 

Pulse output rotation 
direction 

CW 
direction + 

When selecting Pulse/Sign mode: 
CW direction +: Select this setting for the case that the 
elapsed value is increased when Sign output turns off.  
CCW direction +: Select this setting for the case that the 
elapsed value is increased when Sign output turns on. 
When selecting CW/CCW mode: 
CW direction +: Select this setting for the case that the 
elapsed value is increased at the time of CW output.  
CCW direction +: Select this setting for the case that the 
elapsed value is increased at the time of CCW output. 

Startup speed 100 (pps) 

Set the startup speed common to each operation. This 
setting is common to JOG operation, home return, E-point 
control, P-point control, C-point control and J-point control.  
Setting range: 1 to 100,000 

Positioning repeat 
count 0 

Specify this setting for performing repetitive controls when 
using E-point/P-point/C-point control. 
0, 1: Not repeat 
2 to 254: Repeat for the specified number of times. 
255: Repeat infinitely until the execution of stop control. 

Input 

Home position logic Normal 
Open 

Select the input logic for each switch. 
Normal Open、Normal Close 

Home position 
proximity logic 

Normal 
Open 

Limit + switch logic Normal 
Open 

Limit - switch logic Normal 
Open 

Home 
return 
setting 

Home return method Not use DOG method 1, DOG method 2, DOG method 3, Home 
position method, Data set method, Not use 

Home return direction Limit (-) 
direction Limit (-) direction, Limit (+) direction 

Home return 
acceleration time 100 (ms) Setting range: 1 to 10,000 

Home return 
deceleration time 100 (ms) Setting range: 1 to 10,000 

Home return target 
speed 1000 (pps) Setting range: 1 to 100,000 

Home return creep 
speed 100 (pps) Setting range: 1 to 100,000 

Deviation counter 
clear time 1 (ms) Setting range: 1 to 100 

Coordinate origin 0 (pulse) 

When the home return method is Data set method, specify 
a coordinate origin.  
Setting range: -1,073,741,824 to 1,073,741,823 
For the interpolation control, the range is as follows.  
Setting range: -8,388,608 to 8,388,607 

JOG 
operation 
setting 

JOG acceleration time 0 (ms) Setting range: 0 to 10,000 
JOG deceleration time 0 (ms) Setting range: 0 to 10,000 
JOG target speed 1000 (pps) Setting range: 1 to 100,000 

J point change target 
speed 1000 (pps) 

Set this setting for changing the speed during J-point 
control.  
Setting range: 1 to 100,000 

Stop 
setting 

Emergency stop 
deceleration time 100 (ms) Setting range: 1 to 10,000 

Limit stop 
deceleration time 100 (ms) Setting range: 1 to 10,000 



Settings of Control Unit 

4-12 
 

4.2.3 Creating Positioning Data Table 

• The positioning data tables are divided into sheets for each axis, and 20 tables ranging no. 1 
to no. 20 can be set. 

 For independent axis control 
Parameter name Default 

(unit) 
Description 

Operation pattern E: End point Select one from the following operation patterns.  
E: End point, P: Pass point, C: Continuance point, J: Speed point 

Control method I: Increment Select either I: Increment or A: Absolute. 

X-axis movement 
amount 0 (pulse) Input a movement amount. Setting range: -1,073,741,824 to 

1,073,741,823 

Acceleration/deceleration 
method L: Linear For FP0H, only L: Linear can be selected. 

Acceleration time 100 (ms) Set an acceleration time. Setting range: 1 to 10,000 

Deceleration time 100 (ms) Set a deceleration time. Setting range: 1 to 10,000 

Target speed 1000 (pps) Set a target speed. Setting range: 1 to 100,000 

Dwell time 0 (ms) 

Set the time from the completion of the positioning instruction in the 
E-point control until the positioning done flag turns ON. For the C-
point control, it is the wait time between each table. Also, the dwell 
time setting is invalid for the P-point control. 

 For interpolation control 
Parameter name Default 

(unit) 
Description 

Operation pattern E: End point Select one from the following operation patterns.  
E: End point, P: Pass point, C: Continuance point 

Interpolation operation 
Linear 
(Composite 
speed) 

Select a specification method of speed.  
Linear (Composite speed): Specify the speed combining the speed 
of X and Y axes.  
Linear (Long axis speed): Specify the speed on the long axis side 
whose movement amount is large. 

Control method I: Increment Select either I: Increment or A: Absolute. 

X-axis movement 
amount 0 (pulse) Input a movement amount. Setting range: -8,388,608 to +8,388,607 

Y-axis movement 
amount 0 (pulse) Input a movement amount. Setting range: -8,388,608 to +8,388,607 

Acceleration/deceleration 
method L: Linear For FP0H, only L: Linear can be selected. 

Acceleration time 100 (ms) Set an acceleration time. Setting range: 1 to 10,000 

Deceleration time 100 (ms) Set a deceleration time. Setting range: 1 to 10,000 

Interpolation speed 1000 (pps) 
Set either composite speed or long axis speed in accordance with 
the selection of interpolation operation.  
Setting range: 1 to 100,000 

Dwell time 0 (ms) 

Set the time from the completion of the positioning instruction in the 
E-point control until the positioning done flag turns ON. For the C-
point control, it is the wait time between each table. Also, the dwell 
time setting is invalid for the P-point control. 
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 Selection of positioning operation patterns 
• For the E-point control, enter settings in one row. 

• For P-point control (speed change control), C-point control (continuance point control) and J-
point control (JOG positioning control), they should be combined with E-point control of the 
next step as a pair and the settings should be input in two rows. 

 

 Table numbers and activation of positioning 
• Execute the positioning start instruction (F380) in the user program to specify table numbers 

in the Configurator PMX. 

• The unit executes the control under the conditions set in the table by turning on the 
positioning start contact corresponding to a desired channel number (axis number) and table 
number. Specify the first data table number for each control in the program. 

R1
（ ）DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1 
Position control starts.

 

REFERENCE  
For details, refer to "Chapter 5 Operation Patterns". For details of instructions, refer to 
"Chapter 7 Instruction References". 
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4.2.4 Saving Positioning Parameters 

 Saving positioning parameters 
Information on positioning parameters and positioning data tables set on Configurator PMX is 
saved as part of program files. 

PROCEDURE  
1. Select “File” > “Save changes and exit” from the menu bar. 

A confirmation message box appears. 

 
2. Press [Yes]. 

The set information will be saved as part of project files. 

 Export and Import 
• Basic parameters and positioning parameters set can be exported to and imported from the 

Configurator PMX. 

• Information on positioning parameters and positioning tables saved by using the export 
function can be reused between projects. 

PROCEDURE  
1. Select “File” > “Export” from the menu bar. 

The saving destination and file names appear. 

2. Enter a saving destination and file name, and press [Save] button. 

Information on the parameters and positioning data tables will be saved in a file 
with a “.pmx” extension. 

KEY POINTS
 

• When export is executed, information on the positioning data tables will be 
saved along with parameters set in the parameter setting menu. 
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4.2.5 Check on Parameter Data 

• The following procedure is explained on the condition that the Configurator PMX has already 
started. 

PROCEDURE  
1. Select “Debug” > “Check Parameter and Data Values” from the menu bar. 

A message box appears to show the check result. If there is an error in the 
settings for the positioning data tables, an error message will appear and the 
cursor will move to the corresponding error position. 

 

4.2.6 Writing Parameters to Unit (1) 

• Information on parameters that have been set is transferred to the unit along with information 
on programs, comments and system registers. 

• The following procedure is explained on the condition that the Configurator PMX has already 
started. 

PROCEDURE  
1. Select “File” > “Save changes and exit” from the menu bar of the 

Configurator PMX. 

2. When "Do you save the setting?" appears, press [Yes (Y)]. 

3. Select “Online” > “Download To PLC” from the FPWIN GR7 menu bar. 

Positioning data will also be downloaded to the control unit along with information 
on programs, comments and system registers. 
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4.2.7 Writing Parameters to Unit (2) 

• Information on parameters that have been set can also be downloaded to the unit in the 
Configurator PMX. 

• The following procedure is explained on the condition that the Configurator PMX has already 
started. 

PROCEDURE  
1. Select "File" > "Download positioning data" from the menu bar of the 

Configurator PMX. 

A message box for confirming the saving appears. 

 
2. Press the [Yes] button. 

A message confirming the download to the PLC appears. In the RUN mode, a 
message confirming that the mode is switched to the PROG. mode also appears. 

 
3. Press the [Yes] button. 

A message confirming the switching of the operation mode appears. 

 
4. Press the [Yes] button to switch the operation mode. 
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4.3 System Register Settings 

4.3.1 Confirming and Selecting Functions to be Used 

The set condition can be confirmed by the following procedure. The following procedure is 
explained on the condition that the FPWIN GR7 has already started. 

PROCEDURE  
1. Select “Option” > “System register settings” from the menu bar. 

The "PLC Configuration" dialog box appears. 

2. Select "Controller output setting (PLS/PWM)" from the left pane. 

 
3. Confirm the functions to be used and change the settings as necessary. 

4. Press the [OK] button. 

The screen returns to the ladder edit screen. The settings will be downloaded to 
the PLC together with programs. 

KEY POINTS
 

• When the settings are saved in the Configurator PMX, the system registers 
corresponding to the I/O used for the positioning function will be 
automatically set. 

• Change the settings of the corresponding system registers when the home 
input is not used or the PWM output is allocated to other channels. 
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 Settings when using table setting mode 
Parameter 
name No. and setting item Settings 

Controller 
input settings 
(HSC/PLS) 

400 
HSC operation mode 
setting  
(X0 to X2) 

CH0 

Not Set X0 as High Speed Counter 
2 phase input (X0, X1)  
2 phase input (X0, X1) Reset input (X2)  
Addition input (X0)  
Addition input (X0) Reset input (X2)  
Subtraction input (X0)  
Subtraction input (X0) Reset input (X2)  
Individual input (X0, X1)  
Individual input (X0, X1) Reset input (X2)  
Direction distinction (X0, X1)  
Direction distinction (X0, X1) Reset input (X2)  
J-point positioning start input of pulse output CH0 (X0)  

CH1 

Not Set X1 as High Speed Counter 
Addition input (X1)  
Addition input (X1) Reset input (X2)  
Subtraction input (X1)  
Subtraction input (X1) Reset input (X2)  
J-point positioning start input of pulse output CH1 (X1)  

401 
HSC operation mode 
setting  
(X3 to X5) 

CH2 

Not Set X3 as High Speed Counter 
2 phase input (X3, X4)  
2 phase input (X3, X4) Reset input (X5)  
Addition input (X3)  
Addition input (X3) Reset input (X5)  
Subtraction input (X3)  
Subtraction input (X3) Reset input (X5)  
Individual input (X3, X4)  
Individual input (X3, X4) Reset input (X5)  
Direction distinction (X3, X4)  
Direction distinction (X3, X4) Reset input (X5)  
J-point positioning start input of pulse output CH2 (X3)  

CH3 

Not Set X4 as High Speed Counter 
Addition input (X4)  
Addition input (X4) Reset input (X5)  
Subtraction input (X4)  
Subtraction input (X4) Reset input (X5)  
J-point positioning start input of pulse output CH3 (X4)  

Controller 
output 
settings   
(PLS/PWM) 

407  
Positioning control mode 
setting 

Select the table setting mode or FPΣ compatible instruction 
mode. 

402 
Pulse/PWM output 
setting  
(Y0 to YC) 

CH0 
Select the output allocated to each channel. 
Normal output, PWM output, Pulse output [Table setting 
mode], Pulse output [FPΣ compatible instruction mode] 

CH1 
CH2 
CH3 

(Note 1): Displayed items vary according to models. 
(Note 2): Select "Normal input" and "Normal output" for the input and output that is not used for the pulse output 

function or high-speed counter function. 
(Note 3): "J-point positioning start input" for each channel can be selected only when "Table setting mode is set in the 

system register no. 407. 
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4.4 Reading Elapsed Values 

4.4.1 Elapsed Value (Current Value) Area 

• They are stored as 2-word 32-bit data in the axis information area of positioning memory. 

• The elapsed value area will be reset when the power supply turns off. It will be held when 
switching the mode from RUN to PROG. 

 Counting range of elapsed value (current value) area 
Section Range 
For single axis control -1,073,741,824 to 1,073,741,823 

For interpolation axis control -8,388,608 to +8,388,607 

4.4.2 Reading Elapsed Value (Current Value) Area 

Use [F384 PTBLR] positioning parameter read instruction for reading elapsed values. 

 Instruction format 

R0
S2 DnS1F384 PTBLR

 

Operand Settings Specification for reading the elapsed value 
area 

S1 Specification of channel numbers and 
positioning memory area 

H1 Specify the axis information area of CH0. 

H101 Specify the axis information area of CH1. 

H201 Specify the axis information area of CH2. 

H301 Specify the axis information area of CH3. 

S2 Starting address of positioning memory 
(Offset address) K2  Specify the offset address. 

n No. of read words K2 Specify two words. 

D Operation memory storing read data Specify an arbitrary memory. 

 

 Sample program 
The following sample shows the program when reading the elapsed value (current value) of 
CH3 to the data registers DT300 to DT301. For details of instructions, refer to "7Instruction 
References". 

R0
K2 DT300K2H301F384 PTBLR
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5.1 Stop Operation 

5.1.1 Type of Stop Operations 

 Type of stop operations 
Name Time chart Occurrence condition and operation 

System stop 
E

 

 Once the system stop contact (Y800) turns 
on, an active operation will stop and the 
pulse outputs of all channels will immediately 
stop. 
 The similar operation is performed when the 
operation mode of the control unit is 
switched from RUN to PROG. 

Emergency 
stop 

E

Emergency stop deceleration time

 

 Once an emergency stop contact (Y830 to 
Y833) turns on, an active operation will stop 
and the pulse outputs of corresponding 
channels will stop. 
 Performs a deceleration stop in the 
deceleration time specified in the positioning 
parameter setting menu of Configurator 
PMX. 

Limit stop: 

E

Limit stop deceleration time

 

 Once an over limit input (+) and over limit 
input (-) (Y860 to Y867) turns on, an active 
operation will stop and the pulse outputs of 
corresponding channels will stop. 
 Performs a deceleration stop in the "limit 
stop deceleration time" specified in the 
positioning parameter settings. 

Deceleration 
stop 

E

Deceleration time

 

 Once a deceleration stop contact (Y838 to 
Y83B) turns on, an active operation will stop 
and the pulse outputs of corresponding 
channels will stop. 
 Performs a deceleration stop in the 
deceleration time specified for the active 
positioning operation. 
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 Execution of stop operations 
Stop controls are executed when the following I/O signals turn on. 

 Allocation of I/O signals (Output) 

Signal name 
I/O number 

Axis 1 Axis 2 Axis 3 Axis 4 
CH0 CH1 CH2 CH3 

System stop Y800 

Emergency stop Y830 Y831 Y832 Y833 

Over limit input (+) (Note 2) (Y860) (Y862) (Y864) (Y866) 

Over limit input (-) (Note 2) (Y861) (Y863) (Y865) (Y867) 

Deceleration stop Y838 Y839 Y83A Y83B 

(Note 1): The over limit input (+) and over limit input (-) will be valid when arbitrary inputs are allocated and the output 
relays indicated in the above table turn ON. 

5.1.2 Characteristics of Stop Operations 

 Priority of stop operations 
When stop control requests are made simultaneously, the stop operations are executed 
according to the following priority. 

1. System stop > 2. Emergency stop > 3. Limit stop > 4. Deceleration stop 

 Dwell time setting 
The dwell time setting is invalid in the stop operations regardless of patterns. 

 Flag processing 
• In the case of system stop, the busy signal turns off and the operation done signal turns on. 

• In the cases of emergency stop, limit stop and deceleration stop, the busy signal turns off 
and the operation done signal turns on after the completion of the pulse output during 
deceleration. 

 Elapsed value area (Current value coordinate) 
• Even in a stop operation, the elapsed value area is always updated. 

• After the emergency stop, limit stop or deceleration stop, deceleration is performed with 
each specified deceleration time, and the value when the pulse output stops is stored. 

• In the case of system stop, the value when the pulse output stops is stored. 

KEY POINTS
 

• For details of the deceleration stop operations when repetitive control is 
executed, refer to “5.5.3 Stop Operation During Repeat Operation”. 
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5.2 JOG Operation 

5.2.1 Settings and Operations of JOG Operation 

The parameters for JOG operations are specified in the positioning parameter setting menus 
of Configuration PMX. 

Pulses are output while the JOG operation start instruction (F381 JOGST) is executed. 

 

 Operation diagram 

t [ms]

f [Hz]

100ms

20,000Hz

1,000Hz

Instruction start condition

Busy signal

Operation done signal

200ms

JOG operation target speed 20,000
 

 Operations of each contact 
• The BUSY flags (X808 to X80B), which indicate that the motor is running, will turn on when 

the JOG operation starts, and they will turn off when the operation completes. 

• The operation done flags (X810 to X813), which indicate the completion of operation, will 
turn on when the current operation is completed, and they will be held until the next 
positioning control, JOG operation or home return operation starts. 

 Programming cautions 
• The startup contact and flag numbers vary depending on channel numbers (axis numbers). 
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 Settings 
Item Setting example 

Axis setting area 

Startup speed 1,000 Hz 

JOG operation acceleration time 100 ms 

JOG operation deceleration time 200 ms 

JOG operation target speed 20,000 Hz 

 Configurator PMX settings 

 

 Sample program 
The execution condition is set to be always executed. For details of instructions, refer to 
"7Instruction References". 

CH No.00
JOG reverse operation starts.

CH No.0
JOG forward operation starts.

R3
K0F381 JOGST K0

R4
K0F381 JOGST K1

R3

R4

 

 Operation at limit input 
Conditions Direction Limit status Operation 

At startup 

Forward 
Over limit input (+): ON Not executable, Error occurs. 

Over limit input (-): ON Executable 

Reverse 
Over limit input (+): ON Executable 

Over limit input (-): ON Not executable, Error occurs. 

During 
operation 

Forward 
Over limit input (+): ON Limit stops, Error occurs. (Note) 

Over limit input (-): ON Limit stops, Error occurs. (Note) 

Reverse 
Over limit input (+): ON Limit stops, Error occurs. (Note) 

Over limit input (-): ON Limit stops, Error occurs. (Note) 

(Note 1): Create a program as below if you do not want to restart the instruction when the limit error occurs during an 
operation when the execution condition has been set to be always executed. 

R1
K0K0F381 JOGST

R0
（ ）DF

R1

R1

R0

X808

CH No.0
JOG forward operation starts.

R0: JOG start 
R1: JOG start instruction
X808: CH0 BUSY
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5.2.2 Settings and Operations of JOG Operation (Speed Changes) 

It is possible to change a target speed during the JOG operation. The target speed is changed 
by rewriting the positioning memory using a user program. 

 Operation diagram 

t [ms]

f [Hz]

20,000Hz

1,000Hz

100ms

10,000Hz

20,000 10,000

Rewriting the target speed

Approx.100ms Approx.100ms

Instruction start condition

Busy signal

Operation done signal

JOG operation target speed

 

 Operations of each contact 
• The BUSY flags (X808 to X80B), which indicate that the motor is running, will turn on when 

the JOG operation starts, and they will turn off when the operation completes. 

• The operation done flags (X810 to X813), which indicate the completion of operation, will 
turn on when the current operation is completed, and they will be held until the next 
positioning control, JOG operation or home return operation starts. 

 Characteristics of acceleration/deceleration zone when changing speeds 
• In the case o the speed change in the JOG operation, the speed of acceleration zone and 

deceleration zone changes whenever the instruction is executed. The speed variation is 
obtained by the following formula. 

Speed variation = (JOG operation target speed - Startup speed) / (JOG acceleration time or 
JOG deceleration time) 
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 Settings 
Item Setting example 

Axis setting area 

Startup speed 1,000 Hz 

JOG operation acceleration time 100 ms 

JOG operation deceleration time 200 ms 

JOG operation target speed 20,000 Hz → 10,000 Hz 

 Configurator PMX settings 

 

 Sample program 
The execution condition is set to be always executed. For details of instructions, refer to 
"7Instruction References". 

Target speed is 
rewritten.

CH No.0
JOG forward operation starts.

R4
K0F381 JOGST K0

R5
K10000F1 DMV DT100（ ）DF

DT100H2 K16F385 PTBLW K2
 

 Programming cautions 
• To change a speed during the JOG operation, rewrite the value of the positioning memory 

(axis setting area) using a user program. 

• The startup contact and flag numbers vary depending on channel numbers (axis numbers). 

5.2.3 Speed Changes in JOG Operation 

• The value of “JOG operation target speed” in the axis setting area is constantly monitored 
while the operation is being executed. When the target speed is changed, it will be changed 
with the same acceleration. 

• The speed change is executed after the completion of acceleration/deceleration. 

• The speed range in which the JOG operation can be set is 50Hz to 100kHz. When setting a 
value smaller than 50 Hz, it is corrected to 50 Hz. 
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5.3 Home Return 

5.3.1 Types of Home Return 

The home return is specified in the positioning parameter setting dialog box for each axis. 

Name Operation diagram Operation and application 

DOG 
method 
1 

 

 The leading edge of the first home 
input is set as a home position 
after the detection of the leading 
edge of the near home input. 
 Even when the limit input turns 
on, the motor rotation will be 
automatically reversed and the 
home return operation will 
continue.  
 This method is used when the 
home switch exists in the range 
that the near home switch is 
enabled, such as a system using a 
servo motor. This method can also 
be used when no home switch 
exists in the range that the near 
home switch is enabled. 

DOG 
method 
2 

 

 The leading edge of a near home 
input is detected and it is set as a 
home position. 
 Even when the limit input turns 
on, the motor rotation will be 
automatically reversed and the 
home return operation will 
continue.  
 This method is used for 
performing the home return with 
the near home switch only. 

DOG 
method 
3 

 

 The leading edge of the first home 
input in the home return direction 
set as a home position after the 
detection of a trailing edge (back 
end) of the near home input. 
 Even when the limit input turns 
on, the motor rotation will be 
automatically reversed and the 
home return operation will 
continue.  
 This method is used when no 
home switch exists in the range 
that the near home switch is 
enabled. 
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Name Operation diagram Operation and application 

Home 
position 
method 

 

 Moves the current position to the 
home return direction, and stops at 
the position where the rising edge 
of the home input is detected. This 
coordinate is set as the starting 
point. 
 When no home input exists in the 
home return direction, the limit 
input turns on and the operation 
stops. 
 This method is used for 
performing the home return with 
the home switch only. This method 
is compatible with the F171 
instruction of the existing model 
FPΣ. 

Data 
set 
method  

 Performs the home return based 
on the home coordinate values in 
the axis setting area of positioning 
memory. 
 Performs the home return toward 
the home coordinate on the 
software. 
 When the starting point is within 
the limit switch, it cannot be 
started. 
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5.3.2 Operation Patterns of Home Return 

The operations vary according to selected home return methods and the difference in current 
positions. 

 DOG method 1 (Edge detection of near home switch + Home switch, based on front 
end) 

The leading edge of the first home switch is set as a home position after the detection of the 
leading edge of the near home switch. 
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 DOG method 2 (Edge detection of near home switch) 
The leading edge of the near home switch is detected and it is set as a home position. 

 

 DOG method 3 (Edge detection of near home switch + Home switch, based on back 
end) 

The leading edge of the first home switch in the home return direction is set as a home 
position after the detection of the trailing edge (back end) of the near home switch. 
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 Home position method (Edge detection of home switch) 
Moves the current position to the home return direction, and stops at the position where the 
leading edge of the first home switch is detected. This coordinate is set as a home position. 

 

 Data set method 
Performs the home return based on the home coordinate values in the axis setting area of 
positioning memory. 

 

REFERENCE  
For details of addresses and settings of positioning memory, refer to "11.3 Positioning 
Memory". 
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5.3.3 Settings and Operations of Home Return 

• The parameters for home return operations are specified in the positioning parameter setting 
menus of Configuration PMX. 

• When the home return start instruction (F382 ORGST) is executed, the pulse output will start 
and the home return operation will be performed. 

• In the following example, the DOG1 method is selected. After the start, it moves at a target 
speed and reverses at the time of near home detection. After the redetection of near home 
input, it moves at a creep speed until the home position is detected. 

 Operation diagram 
Home return target speed

Home return creep speed

Home return start contact

Near home switch (DOG)

Home switch

Home return done flag

Deviation counetr clear signal

BUSY flag

 

 Operations of each contact 
• The BUSY flags (X808 to X80B), which indicate that the motor is running, will turn on when 

the home return operation starts, and they will turn off when the operation completes. 

• The deviation counter clear signal will turn on after the completion of the home return 
operation. The ON time is set in the axis setting area of the positioning memory. 

• The home return done flags (X828 to X82B), which indicate the completion of home return 
operation, will turn on when the current operation is completed, and they will be held until 
any operation of the positioning control, JOG operation and home return operation starts. 
The timing of turning on the flags is on the completion of the home return. 
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 Settings 
Item Setting example 

Axis setting area 

Return setting code DOG method 1 

Return direction Limit (-) direction 

Acceleration time (ms) 100 ms 

Deceleration time (ms) 100 ms 

Target speed 10000 pps 

Return creep speed 1000 pps 

Deviation counter clear signal 
ON time 1 ms 

 Configurator PMX settings 

 

 Sample program 
The execution condition is differential execution. For details of instructions, refer to 
"7Instruction References". 

R0
（ ）DF F382 ORGST K0

X808

CH0
BUSY

CH No.0
Home return starts.

 

 Operation at limit input 
Conditions Direction Limit status Operation 

At startup 

Forward 
Over limit input (+): ON Executable (Note 2) (Note 3) 

Over limit input (-): ON Executable (Note 3) 

Reverse 
Over limit input (+): ON Executable (Note 3) 

Over limit input (-): ON Executable (Note 2) (Note 3) 

During 
operation 

Forward 
Over limit input (+): ON Automatic reverse operation (Note 4) 

Over limit input (-): ON edge (Note 1) Limit stops, Error occurs. 

Reverse 
Over limit input (+): ON edge (Note 1) Limit stops, Error occurs. 

Over limit input (-): ON Automatic reverse operation (Note 4) 

(Note 1): Only when an edge signal is detected, the limit stop is performed. 
(Note 2): In the case of home position method, it cannot be executed. 
(Note 3): In the case of data set method, it cannot be executed. 
(Note 4): In accordance with situations, “Limit stops or Error occurs” (Example) When the limit input is enabled during 

deceleration, the limit stop is performed without reverse operation. 
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5.4 Positioning Control 

5.4.1 Types of Positioning Control 

 Operation pattern 

Name Time chart Operation and application Repeat Interpo-
lation 

E-point 
control 

t[ms]

f[Hz]

E

 

 This is a method of control 
which is initiated up to an end 
point, and is referred to as “E-
point control”. 
 This method is used for a first 
speed 
acceleration/deceleration. 

  

P-point 
control 

t[ms]

f[Hz]

P
E

 

 This refers to control which 
passes through a “Pass Point”, 
and is called “P-point control”. 
 This method is used for a 
second speed 
acceleration/deceleration. 
 After the pulse output is 
performed for a specified 
movement amount, it shifts to 
the E-point control. 

  

C-point 
control 

t[ms]

f[Hz]

C
E

 

 This refers to control which 
passes through a “Continuance 
Point”, and is called “C-point 
control”. 
 This method is used for 
performing two successive first 
speed positioning control with 
different target speeds or 
acceleration/deceleration times. 
 The time taken for transmitting 
from the C-point control  to E-
point control is specified as a 
dwell time. 

  

J-point 
control 

No speed change 

t[ms]

f[Hz]

J E

 

 This refers to control which 
passes through a speed point 
“JOG Operation Point”, and is 
called “J-point control”. 
 After the start, it is controlled at 
specified speeds. 
 Once the J-point positioning 
contact turns on, the positioning 
control starts. 
 When the J-point control 
speed change flag is set, the 
speed changes. 

－ － Speed changes 

t[ms]

f[Hz]

J E
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 Selection of positioning operation modes 
Positioning operation modes are selected on Configurator PMX. 

• For the E-point control, enter settings in one row. 

• For P-point, C-point and J-point controls, they should be combined with E-point control of the 
next step as a pair and the setting should be input in two rows. 

 

KEY POINTS
 

• When E: End point is not selected in the next row of P: Pass point, C: 
Continuance point or J: Speed point, the self-diagnostic error (error code 
44: positioning error) is detected. 

 Settings of J-point control 
• For J-point control, only "Increment" can be selected as a control method.  

• For changing speed during J-point control, set the target speed after the change in the 
positioning parameter dialog box. 
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5.4.2 E-point Control (First Speed Positioning) 

• The parameters for position control operations are specified in the positioning parameter 
setting menus and data tables of Configuration PMX. 

• When the positioning table start instruction (F380 POSST) or positioning simultaneous start 
instruction (F383 MPOST) is executed, the pulse output will start and the positioning control 
operation will be performed.  

 Operation diagram 

t [ms]

f [Hz]

100ms 200ms

50ms

100,000 pulses

20,000Hz

1,000Hz

Instruction 
start condition

Busy signal

Operation 
done signal

Table 1

 

 Operations of each contact 
• The BUSY flags (X808 to X80B), which indicates that the motor is running, will turn on when 

the positioning control starts, and it will turn off when the operation completes. 

• The operation done flags (X810 to X813), which indicate the completion of operation, will 
turn on when the current operation is completed, and they will be held until the next 
positioning control, JOG operation or home return operation starts. 
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 Settings 
Item Setting example 
Axis setting area Startup speed 1,000 Hz 

Table area 

Table number Table 1 

Control code Increment mode 

Operation pattern E-point control (End point control) 

Positioning acceleration time 100 ms 

Positioning deceleration time 200 ms 

Positioning target speed 20,000 Hz 

Positioning movement amount 100,000 pulses 

Dwell time 50 ms 

 

 Configurator PMX settings 

 

 Sample program 
The execution condition is differential execution. For details of instructions, refer to "7 
Instruction References". 

R1
（ ）DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1 
Position control starts.
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5.4.3 P-point Control (Second Speed Positioning) 

• The parameters for position control operations are specified in the positioning parameter 
setting menus and data tables of Configuration PMX. 

• When the positioning table start instruction (F380 POSST) or positioning simultaneous start 
instruction (F383 MPOST) is executed, the pulse output will start and the positioning control 
operation will be performed. 

 Operation diagram 

t [ms]

f [Hz]

100ms

50ms

50,000 pulses

20,000Hz

1,000Hz

10,000Hz

250ms 250ms

100,000 pulses

Instruction 
start condition

Busy signal

Operation 
done signal

Table 1 Table 2

 

 Operations of each contact 
• The BUSY flags (X808 to X80B), which indicates that the motor is running, will turn on when 

the positioning control starts, and it will turn off when the operation completes. 

• The operation done flags (X810 to X813), which indicate the completion of operation, will 
turn on when the current operation is completed, and they will be held until the next 
positioning control, JOG operation or home return operation starts. 
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 Settings 
Item Setting example 
Axis setting area Startup speed 1,000 Hz 

Table area 

Table number Table 1 Table 2 

Control code Increment mode Increment mode 

Operation pattern P-point control (Pass point 
control) 

E-point control (End point 
control) 

Positioning acceleration time 100 ms 150 ms 

Positioning deceleration time 200 ms 250 ms 

Positioning target speed 20,000 Hz 10,000 Hz 

Positioning movement amount 50,000 pulses 100,000 pulses 

Dwell time － 50 ms 

 

 Configurator PMX settings 

 

 Sample program 
The execution condition is differential execution. For details of instructions, refer to "Chapter 7 
Instruction References". 

R1
（ ）DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1 
Position control starts.
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5.4.4 C-point Control 

• The parameters for position control operations are specified in the positioning parameter 
setting menus and data tables of Configuration PMX. 

• When the positioning table start instruction (F380 POSST) or positioning simultaneous start 
instruction (F383 MPOST) is executed, the pulse output will start and the positioning control 
operation will be performed. 

 Operation diagram 

t [ms]

f [Hz]

100ms

50ms

100,000
pulses

20,000Hz

1,000Hz

10,000Hz

200ms 250ms

50,000
pulses

150ms

30ms
Instruction 

start condition

Busy signal

Operation 
done signal

Table 1 Table 2

 

 Operations of each contact 
• The BUSY flags (X808 to X80B), which indicates that the motor is running, will turn on when 

the positioning control starts, and it will turn off when the operation completes. 

• The operation done flags (X810 to X813), which indicate the completion of operation, will 
turn on when the current operation is completed, and they will be held until the next 
positioning control, JOG operation or home return operation starts. 
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 Settings 
Item Setting example 
Axis setting area Startup speed 1,000 Hz 

Table area 

Table number Table 1 Table 2 

Control code Increment mode Increment mode 

Operation pattern C-point control 
(Continuance point control) 

E-point control  
(End point control) 

Positioning acceleration time 100 ms 150 ms 

Positioning deceleration time 200 ms 250 ms 

Positioning target speed 20,000 Hz 10,000 Hz 

Positioning movement amount 100,000 pulses 50,000 pulses 

Dwell time 30 ms 50 ms 

 

 Configurator PMX settings 

 

 Sample program 
The execution condition is differential execution. For details of instructions, refer to "Chapter 7 
Instruction References". 

R1
（ ）DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1 
Position control starts.
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5.4.5 J-point Control (JOG Positioning Control) 

• The parameters for position control operations are specified in the positioning parameter 
setting menus and data tables of Configuration PMX. 

• When the positioning table start instruction (F380 POSST) or positioning simultaneous start 
instruction (F383 MPOST) is executed, the pulse output will start. In the J-point control, the 
unit operates at a target speed after the startup, and will start the position control when the 
J-point positioning start contacts (X0, X1, X3, X4) turn on. 

(Note 1): In the system registers no. 400 and 401, select "J-point positioning start input of 
pulse output CH*" of the channel to perform the J-point control. 

 Operation diagram 

T [ms]

f [Hz]

100ms
5ms

20,000Hz

1,000Hz

250ms

100000
pulses

15,000Hz

J-point positioning 
start contact

Approx. 250ms

Instruction 
start condition

Busy signal

Operation 
done signal

Table 1 Table 2

 

 Operations of each contact 
• The BUSY flags (X808 to X80B) will turn on when the operation starts and turn off when the 

operation is completed. 

• The operation done flags (X810 to X813) will turn on when the JOG operation is completed, 
and it will be held until the next positioning control, JOG operation, or home return operation 
starts. 

• Positioning control will start when J-point positioning start contacts (X0, X1, X3, X4) turn on. 
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 Settings 
Item Setting example 

Axis setting area 
Startup speed 1,000 Hz 

J-point change speed 10,000 Hz 

Table area 

Table number Table 1 Table 2 

Control code Increment mode Increment mode 

Operation pattern J-point control  
(Speed control) 

E-point control  
(End point control) 

Positioning acceleration time 100 ms 150 ms 

Positioning deceleration time 200 ms 250 ms 

Positioning target speed 20,000 Hz 15,000 Hz 

Positioning movement amount － 100,000 pulses 

Dwell time 30 ms 5 ms 

 

 Configurator PMX settings 

 

 Sample program 
The execution condition is differential execution. For details of instructions, refer to "Chapter 7 
Instruction References". 

R1
（ ）DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1 
Position control starts.
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5.4.6 J-point Control (JOG Positioning: Speed Changes) 

• In the J-point control, the speed can be changed while controlling the speed after the start. 

• After starting the J-point control, the unit operates at the speed specified in the positioning 
parameters of Configurator PMX. 

• The speed changes when the J-point control speed change flag (Y840 to Y843) turns on. 
(Note 1): In the system registers no. 400 and 401, select "J-point positioning start input of 
pulse output CH*" of the channel to perform the J-point control. 

 Operation diagram 

t [ms]

f [Hz]

100ms

50ms

20,000Hz

1,000Hz

10,000Hz

Approx. 50 ms 250ms

100000
pulses

150 ms

15,000Hz

J-point speed 
change

J-point speed 
change contact

J-point positioning 
start contact

Instruction 
start condition

Busy signal

Operation 
done signal

Table 1 Table 2

 

 Operations of each contact 
• The BUSY flags (X808 to X80B) will turn on when the operation starts and turn off when the 

operation is completed. 
• The operation done flags (X810 to X813) will turn on when the JOG operation is completed, 

and it will be held until the next positioning control, JOG operation, or home return operation 
starts. 

• The target speed will be changed when the J-point speed change contacts (Y840 to Y843) 
turn on. The change will be enabled at the edge where the contact turns on. 

• Positioning control will start when J-point positioning start contacts (X0, X1, X3, X4) turn on. 

 Characteristics of acceleration/deceleration zone when changing speeds 
• The speed of speed change zone changes for each scan when changing the speed in the J-

point control. The speed variation is obtained by the following formula. 
(J-point table target speed - Startup speed) / (J-point table acceleration time or J-point table 
deceleration time) 
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 Settings 
Item Setting example 

Axis setting area 
Startup speed 1,000 Hz 

J-point change speed 10,000 Hz 

Table area 

Table number Table 1 Table 2 

Control code Increment mode Increment mode 

Operation pattern J-point control  
(Speed control) 

E-point control  
(End point control) 

Positioning acceleration time 100 ms 150 ms 

Positioning deceleration time 200 ms 250 ms 

Positioning target speed 20,000 Hz 15,000 Hz 

Positioning movement amount － 100,000 pulses 

Dwell time 30 ms 50 ms 

(Note 1): For the J-point control, the set acceleration time and deceleration time is converted as a time between 0 Hz 
to 100 kHz, and the speed tables in the acceleration and deceleration sections are calculated. Therefore, 
when the target speed is below 100 kHz, the actual acceleration/deceleration time is shorter than the set 
values. 

 Configurator PMX settings 

 

 

 Sample program 
The execution condition is differential execution. For details of instructions, refer to "Chapter 7 
Instruction References". 

R1
（ ）DF K1K0F380 POSST K0

X808

CH0
BUSY

CH no.0
Table no. 1
Position control starts.

R6
（ ）DF

Y840
CH0 Speed change
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 Behaviors when the speed change contact turns ON while the positioning unit is 
accelerating or decelerating the speed 

• A speed change is possible during J-point control, but impossible during acceleration or 
deceleration. 

• A speed change will be made after the unit goes to constant speed when the speed change 
signal turns ON during acceleration or deceleration. 

 

KEY POINTS
 

• Specify parameters for the start of operation in the positioning data table. 
The parameters for changing speeds are specified in “Channel setting” > 
“Parameter settings” menu. 

• J-point control can be used for single-axis control only. It is not available 
for interpolation control. 

• Set the unit to increment mode to implement E-point control with positions 
specified after J-point control is implemented. 

• Speed control is performed while the positioning unit is in J-point control, 
in which case, be sure to input the amount of movement for positioning with 
a value that can secure a target constant-speed area. 
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5.4.7 Programming cautions 

 Programming cautions 
• The last table should be set to E: End point. 

• If any value such as a movement amount, acceleration time, deceleration time or target 
speed is out of the specified range, a positioning error will occur when the position control 
starts. 

• The startup contact and flag numbers vary depending on channel numbers (axis numbers). 

 Operation at limit input 
Conditions Direction Limit status Operation 

When each control 
starts 

Forward 
Over limit input (+): ON Not executable, Error occurs. 

Over limit input (-): ON Not executable, Error occurs. 

Reverse 
Over limit input (+): ON Not executable, Error occurs. 

Over limit input (-): ON Not executable, Error occurs. 

When each control 
is performed 

Forward 
Over limit input (+): ON Limit stops, Error occurs. 

Over limit input (-): ON Limit stops, Error occurs. 

Reverse 
Over limit input (+): ON Limit stops, Error occurs. 

Over limit input (-): ON Limit stops, Error occurs. 
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5.5 Repeat Operation 

5.5.1 Overview of Repeat Operation 

• The repeat count is specified for executing the repeat control in Configurator PMX. 

• When the position control start instruction F380 is executed, the unit repeats the operation 
set in the positioning table. 

 Conditions of repeat control 
Item Repeat control is available Repeat control is unavailable 

Operation pattern 
E-point control, P-point control + E-point 
control 
C-point control + E-point control 

JOG operation, J-point control, Interpolation 
control 

Control method Increment mode Absolute mode 

Dwell time setting Set the table of E-point control to 1 ms or 
more. When setting 0 ms. 

 

 Operation diagram (Setting operation on the table) 

 

 Operation diagram (Repeat operation) 
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  Configurator PMX setting items 
Parameter name Unit Default Settings 

Positioning repeat count times 0 

0 or 1 Not repeat an operation. 

2 to 254 Repeat an operation for a specified 
number of times. 

255 Repeat an operation infinitely. 

 Configurator PMX settings 

 

KEY POINTS
 

• When selecting “255: Repeat infinitely” in the parameter of positioning 
repeat count, create a program to stop the operation using the deceleration 
stop function. 
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5.5.2 Settings and Operations of Repeat Operation 

• The parameter for the repeat count is specified in the positioning parameter setting menus of 
Configuration PMX. 

• When the positioning table start instruction (F380 POSST) or positioning simultaneous start 
instruction (F383 MPOST) is executed, the pulse output will start. 

• After starting the instruction, the unit executes the pulse output for a specified repeat count 
and then stops the operation. For setting to execute the operation infinitely, use this function 
in combination with the deceleration stop function. 

 

 Operation diagram 

 

 Operations of each contact 
• The BUSY flags (X808 to X80B), which indicate that the motor is running, will turn on when 

the position control starts, and they will turn off when the set repeat operation completes. 

• The operation done flags (X810 to X813), which indicate the completion of operation, will 
turn on when the current operation is completed, and they will be held until the next 
positioning control, JOG operation or home return operation starts. Those flags do not turn 
off in the middle of the repeat operation. 
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 Settings 
Item Setting example 

Common area 
Axis setting Turn on the single axis setting for an appropriate axis. 

Positioning repeat count 3 

Axis setting area 
Pulse output control code Set in accordance with system configuration. 

Startup speed 1,000 Hz 

Table area 

Table number Table 1 Table 2 

Control code Increment mode Increment mode 

Operation pattern P-point control (Pass point 
control) 

E-point control (End point 
control) 

Positioning acceleration time 100 ms 150 ms 

Positioning deceleration time 200 ms 250 ms 

Positioning target speed 20,000 Hz 10,000 Hz 

Positioning movement amount 5,000 pulses 10,000 pulses 

Dwell time － 50 ms 

 Configurator PMX settings 

 

 

 Sample program 
The execution condition is differential execution. For details of instructions, refer to "Chapter 7 
Instruction References". 

R1
（ ）DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1 
Position control starts.
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5.5.3 Stop Operation During Repeat Operation 

• When setting the repeat function, the operation at the time of deceleration stop varies as 
follows. 

 Operation at the time of deceleration stop (Repeating E-point control) 
When the unit detects a deceleration stop, the unit will come to a stop after repeating 
positioning control N+2 times. However, the unit will stop the control when reaching the set 
repeat count. 

 

 Operation at the time of deceleration stop (Repeating P-point control, C-point 
control) 

When the unit detects a deceleration stop, it stops the operation after repeating the 
positioning control N+1 times. However, the unit will stop the control when reaching the set 
repeat count. 

 

KEY POINTS
 

• When a system stop is executed, the unit will stop the pulse output 
immediately without repetitive operations. 

• When an emergency stop is executed, the unit will stop the pulse output 
after a specified emergency stop setting time without repetitive operations. 
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5.6 Linear interpolation control 

5.6.1 Overview 

The interpolation control is available under the following conditions. 

 Combinations of interpolation control 
Interpolation axis 1 Interpolation axis 2 

X-axis Y-axis X-axis Y-axis 
CH0 CH1 CH2 CH3 

 Conditions of interpolation control 

Item 
Condition under which interpolation control is executable 
Available Not available 

Operation pattern 
E-point control 
P-point control + E-point control 
C-point control + E-point control 

JOG operation 
Home return (Note 1) 
J-point control 

Control method Increment mode, Absolute mode - 

Dwell time setting Set the E-point control to 1 ms or more When set to 0 ms, the positioning error occurs. 

(Note 1): In the home return operation, the home return start instruction (F382 ORGST) is executed for each channel 
corresponding to X and Y axes. The trajectory is not linear interpolation. 

 Setting method of speed 
Item Composite speed Long axis 

Operation 

  

Setting method Specify the speed combining the speed 
of X and Y axes. 

Specify the speed for the axis whose 
movement amount is large. 

(Note): When specifying the same value, the long axis speed is faster than the composite speed. 
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5.6.2 Settings and Operations of Linear Interpolation 

The example below is a case of E-point control with the unit installed in slot 1. The X axis is 
set to the 1st axis and the Y axis is set to the 2nd axis. The movement amount setting is the 
increment method, and the unit is set to pulse. 

 

 Operation diagram 

100 100

f [pps]

10000

t [ms]

Composite speed

Operation done flag of axis 1

Operation done flag of axis 2

BUSY flag of axis 1

BUSY flag of axis 2

Start Condition

 

 Operations of each contact 
• The BUSY flags (X808, X809), which indicates that the motor is running, will turn on when 

the positioning control starts, and it will turn off when the operation completes. 

• The operation done flags of axes 1 and 2 (X810, X811), which indicates the completion of 
operation, will turn on when the current operation is completed, and it will be held until the 
next positioning control, JOG operation or home return operation starts. 
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 Settings 
Item Setting example 

Common area 
Axis setting Turn on the single axis setting for an appropriate axis. 

Positioning repeat count 0 

Axis setting area 
Pulse output control code Set in accordance with system configuration. 

Startup speed 1,000Hz 

Table area 

Operation pattern E:  End point 

Interpolation operation 0:  Linear (Composite speed) 

Control method I:  Increment 

X-axis movement amount 10000 pulses 

Y-axis movement amount 5000 pulses 

Acceleration/deceleration method L:  Linear 

Acceleration time (ms) 100 ms 

Deceleration time (ms) 100 ms 

Interpolation speed 10000 pps 

Dwell time 0 ms 

 Sample program 
The execution condition is differential execution. For details of instructions, refer to 
"7Instruction References". 

R1
（ ）DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1
Position control starts.

X809

CH1
BUSY

 

 Programming cautions 
• Specify a smaller channel number in the same group for starting the interpolation control. 

• If any value such as a movement amount, acceleration time, deceleration time or target 
speed is out of the specified range, a positioning error will occur when the position control 
starts. 

• The startup contact and flag numbers vary depending on channel numbers (axis numbers). 
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6.1 Operational Difference Between Parameters 

6.1.1 Startup speed 

• The startup speed is the parameter for setting the initial speed when starting each operation 
and the speed when finishing each operation. 

• The startup speed is common to each control of the JOG operation, home return, E-point 
control, P-point control, C-point control and J-point control operations. It is set for each 
channel number (axis number). 

 Setting method of startup speed 
It is set in the “Parameter settings” dialog box of Configurator PMX. 

 

 Precautions when setting the startup speed 
• The home return creep speed setting is not influenced by the startup speed in the home 

return operation. 

• The target speed of each operation is not influenced by the startup speed. Each operation is 
performed at each specified target speed regardless of the setting of startup speed. 

6.1.2 Operations When Target Speed/Startup Speed is Less Than 50 Hz 

 Operation 
Operation 
pattern Speed setting Operation 

E-point control 

When target speed is less than 
50 Hz 

Operation is performed with the set target speed. The startup 
speed setting is invalid and the acceleration/deceleration 
operation is not performed. 

When startup speed is less than 
50 Hz 

When the target speed is set to 50 Hz or more, the startup 
speed is corrected to 50 Hz and the table operation is 
performed. 

P-point control  
C-point control  
J-point control  
JOG operation 

When target speed is less than 
50 Hz 

The target speed is corrected to 50 Hz and the table operation 
is performed. 

When startup speed is less than 
50 Hz 

The startup speed is corrected to 50 Hz and the table operation 
is performed. 
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6.1.3 Operation Patterns and Start Speed Settings 

Operation 
pattern Startup speed setting 

JOG 
operation 

1

2

f

t
 

① Startup speed 

② Target speed 

Home 
return 

1

2

f

t

3

 

① Startup speed 

② Target speed 

③ Creep speed 

E-point 
control 

1

2

f

t
 

① Startup speed 

② Target speed 

P-point 
control 

1

2

f

t

3

 

① Startup speed 

② P-point target speed 

③ E-point target speed 

C-point 
control 

1

2

f

t

3

 

① Startup speed 

② C-point target speed 

③ E-point target speed 

J-point 
control 

1

2

f

t

3

4

 

① Startup speed 

② J-point target speed 

③ J-point change speed 

④ E-point target speed 
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6.2 Other Characteristics 

6.2.1 Backup of Positioning Memory 

• The positioning parameters and positioning table data set in the unit will be also held in the 
memories of the control unit when the control unit is powered off. They will be also held 
when the mode is switched from RUN to PROG. 

• The elapsed value area (current value of position data) in the axis information area will be 
reset to zero when the unit is powered off. However, when the RUN mode is switched to 
PROG. mode, the latest value will be held. 

6.2.2 Activation of Each Operation 

• When any of the JOG operation, home return and position control is activated, it does not 
transit to other operation even if an instruction to activate the other instruction turns on. 
Create a program to confirm the busy signals (X808 to X80B) allocated to each axis and to 
start instructions. 

• Stop operations (system stop, emergency stop, limit stop, deceleration stop) have priority 
even during other operations. Each operation is executed by turning on the stop signal 
allocated to each axis. 

6.2.3 Operation When PLC Mode Changes From RUN To PROG. 

• When the mode of CPU Unit changes from RUN to PROG. after starting the JOG operation, 
home return or position control (E-point control, P-point control, C-point control, J-point 
control), each operation stops. 

• As well as the execution of the system stop, the unit stops the pulse output immediately. 
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7.1 Table Setting Mode Control Instruction 

7.1.1 [F380 POSST] Positioning table start instruction 

Starts the positioning operation according to the data specified in the positioning memory 
(positioning table area). This instruction is used to start the E point control, P point control, C 
point control, J point control or linear interpolation control. 

 Instruction format 

R0
（ ）DF S2S1F380 POSST S3

 

 Operand 
Operand Settings Setting range 

S1 Channel number to start the positioning operation (Unsigned 16-bit 
integer) 0 to 3 

S2 Table number to start (Unsigned 16-bit integer) 1 to 20 

S3 Output assignment 0 (Pulse output),  
1 (Calculation only) 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S1 A A A A A A A A A A A A 
S2 A A A A A A A A A A A A 
S3 A A A A A A A A A A A A 

 Outline of operation 
• Starts the positioning operation according to the data specified in the positioning memory 

(positioning table area). 
• When Calculation only is specified for [S3], only the table calculation is executed. When 

starting the positioning operation for the same channel and the same table from the next 
scan after executing the calculation, the startup time of the positioning control is reduced. 

 Precautions during programming 
• If an operand is an out-of-range value, an operation error occurs. 
• The stop operation has priority when the conditions of system stop, emergency stop, limit 

stop and deceleration stop are satisfied. 

• An operation error occurs when the system register of a specified channel is other than 
“Pulse output [Table operation]”. 

• A self-diagnostic error (positioning operation error) occurs when the set value or the value of 
the positioning memory (axis setting area) is abnormal. 

• When the channel to be started has been already operating, the positioning control does not 
start and it terminates. 
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7.1.2 [F381 JOGST] JOG operation start instruction 

Starts the JOG operation according to the parameters specified in the positioning memory 
(axis setting area). 

 Instruction format 

R0
S1F381 JOGST S2

 

 Operand 
Operand Settings Setting range 

S1 Channel number to start the JOG operation (Unsigned 16-bit 
integer) 0 to 3 

S2 Operating direction (Unsigned 16-bit integer) 0 (Forward), 1 (Reverse) 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S1 A A A A A A A A A A A A 
S2 A A A A A A A A A A A A 

 Outline of operation 
• Executes the JOG operation according to the JOG operation parameters specified in the 

positioning memory (axis setting area). While the execution condition is valid, the JOG 
operation continues. 

• The target speed can be changed by rewriting the positioning parameter area with a user 
program. The change is executed after it becomes a constant speed. 

 Precautions during programming 
• If an operand is an out-of-range value, an operation error occurs. 

• The stop operation has priority when the conditions of system stop, emergency stop, limit 
stop and deceleration stop are satisfied. 

• An operation error occurs when the system register of a specified channel is other than 
“Pulse output [Table operation]”. 

• A self-diagnostic error (positioning operation error) occurs when the set value or the value of 
the positioning memory (axis setting area) is abnormal. 

• The JOG operation needs to be stopped for switching between the forward rotation and 
reverse rotation. 

• In case of changing a speed, when the target speed after the change is an out-of-range 
value, the speed change is not executed and the operation continues. 
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7.1.3 [F382 ORGST] Home return start instruction 

Starts the home return operation according to the parameters specified in the positioning 
memory (axis setting area). 

 Instruction format 

R0
（ ）DF F382 ORGST S

 

 Operand 
Operand Settings Setting range 

S Channel number to start the home return (Unsigned 16-bit integer) 0 to 3 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S A A A A A A A A A A A A 

 Outline of operation 
• Starts the home return operation according to the home return parameters specified in the 

positioning memory (axis setting area). 

 Precautions during programming 
• If an operand is an out-of-range value, an operation error occurs. 

• The stop operation has priority when the conditions of system stop, emergency stop, limit 
stop and deceleration stop are satisfied. 

• An operation error occurs when the system register of a specified channel is other than 
“Pulse output [Table operation]”. 

• When the home return pattern is “DOG method 1”, “DOG method 3” or “Home return 
method”, an operation error occurs if the home input has not been set in the system register. 
When the home return pattern is “DOG method 2” or “Data set method”, the home return 
starts even if the home input has not been set. 
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7.1.4 [F383 MPOST] Positioning table simultaneous start instruction 

Starts the positioning tables for multiple axes specified on Configurator PMX. The tables of 
the E point control, P point control and C point control can be started. 

 Instruction format 

R0
（ ）DF F383 MPOST S

 

 Operand 
Operand Settings 

S The starting area of the data register storing the data table numbers (unsigned 16-bit integer) to be 
started simultaneously 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S － － － － － － A － － － － A 

 Outline of operation 
• Starts the positioning table numbers of the channels specified in the area starting with [S] 

simultaneously. 

• Positioning tables that can be specified are those for the single-axis control only. 

• Table numbers are specified in the range of 0 to 20. In the case of 0, the table is not 
executed simultaneously with other tables. 

S Output specification (0: Pulse output, 1: Calculation only) 

S+1 CH0 Positioning table number (0 to 20) 

S+2 CH1 Positioning table number (0 to 20) 

S+3 CH2 Positioning table number (0 to 20) 

S+4 CH3 Positioning table number (0 to 20) 

 Precautions during programming 
• If an operand is an out-of-range value, an operation error occurs. 

• The stop operation has priority when the conditions of system stop, emergency stop, limit 
stop and deceleration stop are satisfied. 

• An operation error occurs when the system register of a specified channel is other than 
“Pulse output [Table operation]”. 

• Only when all the specified channels can be started, they are executed simultaneously. 
When the BUSY flag of any channel is on, tables are not started simultaneously and the 
process is terminated. 

• Use F380 POSST instruction to start linear interpolation. When the table of the interpolation 
axis control has been specified with F383 MPOST instruction, a self-diagnostic error 
(positioning operation error) occurs. 
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7.1.5 [F384 PTBLR] Positioning parameter read instruction 

Reads the positioning parameter data stored in the positioning memory of the unit to the 
operation memory area. 

 Instruction format 

R0
S2 DnS1F384 PTBLR

 

 Operand 
Operand Settings 

S1 

Specification of channel numbers and positioning memory area 

 (Higher 8 bits) channel no.: H0 to H3 

 (Lower 8 bits) Area no.: 
H00 (Common area), H01 (Axis information area), H02 (Axis 
setting area),  
H03 (Positioning table area) 

S2 Starting address of the positioning memory storing read data (offset address) or operation memory 
area storing the starting address 

n No. of read words 

D Operation memory storing read data 

(Note 1): When reading the common area, the setting of channel numbers is invalid. 
(Note 2): The operand S1 is specified using a combination of hexadecimal numbers. For the axis information area of 

channel number 3, specify H301. 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S1 A A A A A A A A A A A A 
S2 A A A A A A A A A A A A 
n A A A A A A A A A A A A 
D － A A A A A A A A － － A 

 Outline of operation 
•  Reads [n] words of the data stored in the positioning memory starting with [S2], and stores it 

in the operation memory area starting with [D]. 

• Channel numbers and the type of positioning memory is specified by [S1]. 

 Precautions during programming 
• If an operand is an out-of-range value, an operation error occurs. 
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7.1.6 [F385 PTBLW] Positioning parameter write instruction 

This instruction is used to write positioning parameters and positioning table data with user 
programs. 

 Instruction format 

R0
S2 DnS1F385 PTBLW

 

 Operand 
Operand Settings 

S1 

Specification of channel numbers and positioning memory area 
 (Higher 8 bits) channel no.: H0 to H3 (Not save in FROM), H80 to H83 (Save in FROM) 

 (Lower 8 bits) Area no.: 
H00 (Common area), H01 (Axis information area), H02 (Axis 
setting area),  
H03 (Positioning table area) 

S2 Operation memory area storing written data 
n No. of written data 

D Starting address of the positioning memory storing data (offset address) or operation memory area 
storing the starting address 

(Note 1): When writing data to the common area, the setting of channel numbers is invalid. 
(Note 2): The operand S1 is specified using a combination of hexadecimal numbers. For the axis setting area of 

channel number 3, specify H302. 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S1 A A A A A A A A A A A A 
S2 A A A A A A A A A - - A 
n A A A A A A A A A A A A 
D A A A A A A A A A A A A 

 Outline of operation 
• Reads [n] words of the data stored in the area starting with [S2], and stores it in the 

positioning memory area starting with [D]. 

• Channel numbers and the type of positioning memory is specified by [S1]. 

 Precautions during programming 
• If an operand is an out-of-range value, an operation error occurs. 

• When specifying [H80 to H83 (Save in FROM)] for the higher 8 bits of operand [S1] (the 
most significant bit is1), specified data is written into the F-ROM of the control unit. Writing to 
F-ROM can be performed up to 10000 times. We recommend using differential execution to 
prevent the writing from being executed continuously. 

REFERENCE  
For details of positioning memory, refer to "11.3 Positioning Memory".
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8.1 Self-diagnostic Function 

8.1.1 Operation Monitor LEDs of Control Unit 

  

• The control unit has a self-diagnostic function which identifies errors and stops operation if 
necessary. 

• When an error occurs, the status of the status indicator LEDs on the control unit vary, as 
shown in the table above. 

 LEDs related to self-diagnostic errors 

 
LED display 

Description Operation 
status RUN 

(Green) 
PROG 

(Green) 
ERR/ALM 

(Red) 

In normal 
condition 

ON OFF OFF Normal operation Operating 

OFF ON OFF 
Program mode  
LED does not flash even if the forcing 
output is performed in program mode. 

Stop 

Flashes  
(Note 1) 

Flashes  
(Note 1) OFF 

Forcing input/output in RUN mode  
RUN and PROG. LEDs flash 
alternately. 

Operating 

Flashes  
(Note 2) 

Flashes  
(Note 2) OFF During version upgrade Stop 

Abnormal 
condition 

ON OFF Flashes Self-diagnostic error (During 
operation) Operating 

OFF ON Flashes Self-diagnostic error (During stop) Stop 

OFF ON ON System watchdog timer has been 
activated Stop 

(Note 1): The flashing is repeated every 1 second. (ON for 0.5 seconds ⇔ OFF for 0.5 seconds) 
(Note 2): The LEDs flash quickly while upgrading the version. The flashing changes to a slow flashing while rewriting 

the version. 
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8.1.2 Operation Mode When an Error Occurs 

• Normally, when an error occurs, the operation stops. 

• For some errors, the user may select whether operation is to be continued or stopped by 
setting the system registers. 

 "PLC Configuration" dialog box of FPWIN GR7 
To specify the steps to be taken by the FPWIN GR7 if a PLC error occurs, select "System 
register settings" under "Option" on the menu bar, and click on the "Action on Error" tab. The 
screen shown below is displayed. 

 

KEY POINTS
 

• When the checkbox of the system register no. 25 "Stop operation when 
positioning operation error occurs" is unchecked, only the operation of the 
axis in which the positioning error occurs stops and the operations of other 
axes continues. 
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8.2 What to Do If an Error Occurs 

8.2.1 ERR/ALM LED Flashes 

 Situation 
A syntax error or self-diagnostic error has occurred. The following shows the procedure when 
a positioning error has occurred. 

 Solution 

PROCEDURE  
1. Check the error code using the programming tool. 

If a PLC error occurs during programming or debugging, the "Status Display" 
dialog box will appear automatically. 

 
2. In the case of the positioning operation error, press the [Positioning errors]  

button. 

The channel number where the positioning error has occurred and the error code 
occurred when using the table setting mode appears.. 

 

3. Press the [Clear Error Log] button. 
A confirmation message appears. 
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4. Press the [Yes] button. 

The positioning error log will be cleared. 

5. Press the [Close] button. 

It returns to the "Status Display" dialog box. 

6. Press the [Clear errors] button. 

The display of the self-diagnostic error message will be cleared. 

7. Correct the positioning parameters or positioning tables according to the 
positioning error code confirmed in step 2. 

8. Download the corrected positioning parameters or positioning table data. 

 Error Codes and How to Handle Them 
Error code Situation Solution 

1 to 9 Syntax error occurs. 
 Change to PROG. mode and clear the error. 
 Execute a total-check function using FPWIN GR7 to determine the 
location of the syntax error and correct the program. 

20 or more Self-diagnostic error 
occurs. 

 Refer to the list of error codes and correct the settings or programs. 
 Use the programming tool in PROG. mode to clear the error. 

 

KEY POINTS
 

• In the case of an error code 43 or higher, the error can be cleared by 
pressing the [Clear errors] button in the "Status Display" dialog box. In the 
PROG. mode, the power supply can be turned off and then on again to clear 
the error, but all of the contents of the operation memory except hold type 
data will be cleared. 

• When the positioning error (error code 44) occurs, the detailed information 
on the error can be confirmed. Press the [Positioning errors] button to 
check the error code.  

• When an operation error (error code 45) occurs, the address at which the 
error occurred is stored in special data registers DT90017 and DT90018. If 
this happens, click on the “Operation errors” button in the “Status display 
dialog box” and confirm the address at which the error occurred before 
canceling the error. 
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8.2.2 What to Do When Positioning Error Occurs 

The following are the solutions when the self-diagnostic error (error code 44: positioning error) 
occurs. 

 Positioning error code 
Error 
code Error name Description Operation when an error 

occurs and solution 

10H Limit + signal detection The input on the plus side of the limit turned 
on. (Note) 

The operation stops in the limit 
stop time specified in the axis 
setting area. 
After the stop, execute the 
home return or JOG operation 
in the reverse direction. 
Correct the setting of the 
parameter. 

11H Limit - signal detection The input on the minus side of the limit 
turned on. (Note) 

12H Limit signal error Both inputs on the plus and minus sides of 
the limit turned on. 

20H Axis setting error The axis setting is incorrect. 

Each control operation does not 
start. Correct the setting of the 
parameter. 

21H Limit stop deceleration 
time error 

The set value of the limit stop deceleration 
time is out of the range. 

22H Emergency stop 
deceleration time error 

The set value of the emergency stop 
deceleration time is out of the range. 

23H Startup speed error The set value of the startup speed is out of 
the range. 

24H Home return setting code 
error 

The set value of the home return setting 
code is out of the range. 

25H Home return target speed 
error 

The set value of the home return target 
speed is out of the range. 

26H Home return acceleration 
time error 

The set value of the home return 
acceleration time is out of the range. 

27H Home return deceleration 
time error 

The set value of the home return 
deceleration time is out of the range. 

28H Home return creep speed 
error 

The set value of the home return creep 
speed is out of the range. 

29H Home return direction error The set value of the home return direction is 
out of the range. 

30H JOG operation target 
speed error 

The set value of the JOG operation target 
speed is out of the range. 

31H JOG operation 
acceleration time error 

The set value of the JOG operation 
acceleration time is out of the range. 

32H JOG operation 
deceleration time error 

The set value of the JOG operation 
deceleration time is out of the range. 

(Note): The error occurs only when the condition of the limit stop is satisfied. 
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Error 
code Error name Description Operation when an error 

occurs and solution 

41H Table setting error The combination of tables is incorrect. 

Each control operation does not 
start. Correct the setting of the 
parameter. 

42H Operation pattern error The set value of the operation pattern is 
incorrect. 

43H Positioning acceleration 
time error 

The set value of the positioning acceleration 
time is out of the range. 

44H Positioning deceleration 
time error 

The set value of the positioning deceleration 
time is out of the range. 

45H Positioning target speed 
error 

The set value of the positioning target 
speed is out of the range. 

46H Positioning movement 
amount error 

The set value of the positioning movement 
amount is out of the range. 

47H Dwell time error The set value of the dwell time is out of the 
range. 

48H J point control setting error The J-point control is set on the 
interpolation axis table. 

60H Repeat operation dwell 
time setting error 

The dwell time of the E table which 
performs repetitive operations is 0 ms. 

 

 Error code 41: Occurrence condition of table setting error 
• The last table of the positioning setting tables is not the E point. (e.g. The P point, C point 

and J point are set continuously.) 

• The control method of the J-point control table is absolute. 

• The tables whose control method is absolute are set repeatedly. 

• The opposite pulse output directions (forward/reverse) are set on the consecutive tables of 
P+E points. 

• Axes to which the interpolation operation setting is made are selected for the F383 
simultaneous start instruction. 
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8.2.3 Motor Does Not Rotate/Move (Output LED Flashes or is ON) 

 Solution 1: For servo motor 
Check to make sure the servo on input is set to “ON”. 

 Solution 2 
Check to make sure the power supplies for the servo amplifier and motor driver are ON. 

 Solution 3 
Check to make sure the servo amplifier and motor driver are connected to the unit correctly. 

 Solution 4 
Check to make sure the settings for the pulse output method (CW/CCW method or Pulse/Sign 
method) are appropriate. 

8.2.4 Motor Does Not Rotate/Move (Output LED is OFF) 

 Solution 
Review the program. 

Point to check 
• Check to make sure the I/O numbers are appropriate. 

• Check non-rewriting of the start flag in the program. 

• Check the input valid logic of the over limit switch. In this case, the error LED flashes. 

8.2.5 Rotation/Movement Direction is Reversed 

 

 Solution 1 
Check to make sure the servo amplifier and motor driver are connected to the unit correctly. 

 Solution 2 
Change the pulse output rotation direction of the parameters for each axis, and set it to the 
reverse direction.  

Point to check 
Check to make sure the CW/CCW output or the Pulse/Sign output is connected to the 
pertinent input of the servo amplifier and motor driver. 
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9.1 PWM Output Function 

9.1.1 Overview of PWM Output Function 

The pulse output of an arbitrary duty ratio can be performed. 

 

 Comparison of functions and performances 
Channel no. Output no. Control flag 
CH0 Y0 R911C 

CH1 Y3 R911D 

CH2 Y8 R911E 

CH3 YB R911F 

(Note 1): Functions, channel numbers and I/O numbers used are set in the tool software. 
(Note 2): I/O numbers used for each function should be allocated so that they do not overlap. 

9.1.2 System register settings 

Functions to be used are allocated in the system register settings dialog box. The following 
procedure is explained on the condition that the FPWIN GR7 has already started. 

PROCEDURE  
1. Select “Option” > “System register settings”. from the menu bar. 

The "PLC Configuration " dialog box appears. 

2. Select "Controller output setting (PLS/PWM)" from the left pane. 

The menu for setting "System register no. 402" appears. 
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3. Change the settings for the channels used for the PWM output. 

4. Press the [OK] button. 

The screen returns to the ladder edit screen. The settings will be downloaded to 
the PLC together with programs and comments. 

 System register relating to PWM output 
Classification No. and setting item Settings 

Controller output 
settings   
(PLS/PWM) 

402 
Pulse PWM output 
setting  
(Y0 to YC) 

CH0 Set the PWM output (Y0) and normal output (Y1). 

CH1 Set the PWM output (Y3) and normal output (Y4). 

CH2 Set the PWM output (Y8) and normal output (Y9). 

CH3 Set the PWM output (YB) and normal output (YC). 

(Note 1): Select "Normal output" for the output that is not used for the pulse output function or PWM output function. 
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9.1.3 [F173 PWMH] PWM Output Instruction (FP0H Instruction Mode) 

Performs the PWM output according to the set parameters. 

 Instruction format 

R0
SF173 PWMH n

 

 Operand 
Operand Settings 

S 

Starting address the memory area storing the parameters of the PWM output. 

S Specify the control code HFF. 

S+1 Specify the output frequency in 2-word 32-bit data.  
Setting range: K1 to K100000 (1 Hz to 100 kHz: in 1 Hz increments) S+2 

S+3 
Duty ratio (Resolution of 1000 or 100)  
For the output frequencies 1 to K70000, Setting range: K0 to K1000 (0.0% to 100.0%)  
For the output frequencies K70001 to K100000, Setting range: K0 to K1000 (0% to 100%)  

n Channel nos. used for PWM output:   0 (CH0: Y0), 1 (CH1: Y3), 2 (CH2: Y8), 3 (CH3: YB) 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S - - - - - - A - - - - A 
n - - - - - - - - - A A - 

 Outline of operation 
• The PWM output is performed form a specified output. The output is performed when the 

trigger (execution condition) is on. 

• The output frequency and duty ratio is specified in the operands [S1+1] to [S1+3]. 

 Precautions during programming 
• This instruction cannot be executed when a control flag corresponding to each channel is on. 

• The duty may be different from the set ratio according to the load voltage and load current 
especially in the vicinity of minimum and maximum values. The duty can be changed for 
each scan. However, the control code cannot be changed during the execution of an 
instruction. 
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 Example of program 
The following sample shows the program for performing the PWM output with 10 kHz and the 
duty ratio of 50% from CH0 (Y0). 

CH No.0 PWM

FP0H PWM
K10000:10KHz
K500:50.0%

R0
HFFF0 MV DT0

R1
DT0F173 PWMH K0

（ ）DF

K10000F1 DMV DT1

K500F0 MV DT3
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9.1.4 [F173 PWMH] PWM Output Instruction (FPΣ Compatible Instruction 
Mode) 

The PWM output is performed according to the set parameters. 

 Instruction format 

R0
SF173 PWMH n

 

 Operand 
Operand Settings 

S 

Starting address the memory area storing the parameters of the PWM output. 

S Specify the control code. K0 to K30 

S+1 
Duty ratio (Resolution of 1000 or 100)  
For the control codes K0 to K27, Setting range: K0 to K1000 (0.0% to 100.0%)  
For the control codes K28 to K30, Setting range: K0 to K1000 (0% to 100%) 

n Channel nos. used for PWM output:  0 (CH0: Y0), 1 (CH1: Y3), 2 (CH2: Y8), 3 (CH3: YB) 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S - - - - - - A - - - - A 
n - - - - - - - - - A A - 

 Outline of operation 
• The PWM output is performed form a specified output. The output is performed when the 

trigger (execution condition) is on. 

• The output frequency and cycle are determined by a specified control code The duty ratio is 
specified in the operand [S1+1]. 

 Precautions during programming 
• This instruction cannot be executed when a control flag corresponding to each channel is on. 

• The duty may be different from the set ratio according to the load voltage and load current 
especially in the vicinity of minimum and maximum values. The duty can be changed for 
each scan. However, the control code cannot be changed during the execution of an 
instruction. 
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 Control code 

S Frequency 
(Hz) Cycle (ms) Resolution S Frequency 

(Hz) 
Cycle 
(ms) Resolution 

K0 1.5 666.67 

1000 

K16 2000.0 0.50 

1000 

K1 2.0 500.00 K17 3000.0 0.33 

K2 4.0 250.00 K18 6000.0 0.17 

K3 6.0 166.67 K19 12500.0 0.08 

K4 8.0 125.00 K20 15000.0 0.067 

K5 10.0 100.00 K21 20000.0 0.050 

K6 20.0 50.00 K22 25000.0 0.040 

K7 50.0 20.00 K23 30000.0 0.033 

K8 100.0 10.00 K24 40000.0 0.025 

K9 200.0 5.00 K25 50000.0 0.020 

K10 400.0 2.50 K26 60000.0 0.017 

K11 500.0 2.00 K27 70000.0 0.0143 

K12 700.0 1.48 K28 80000.0 0.0125 

100 K13 1000.0 1.00 K29 90000.0 0.0111 

K14 1300.0 0.77 K30 100000.0 0.010 

K15 1600.0 0.625     

 

 Example of program 
The following sample shows the program for performing the PWM output with 1kHz and the 
duty ratio of 50% from CH0 (Y0). 

CH No.0 PWM

FPΣ PWM
K13: f=1KHz

T=1ms
K500:50.0%

R0
K13F0 MV DT0

R1
DT0F173 PWMH K0

（ ）DF

K500F0 MV DT1
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10.1 Overview of High-speed Counter Function 

10.1.1 Overview of High-speed Counter Function 

• This function allows the counting of input signals from external devices at high speed such 
as a sensor and encoder. 

• Exclusive instructions (F166 and F167) are provided for turning on or off arbitrary outputs 
(Y0 to Y1F) in the interrupt processing when the elapsed value matches the target value. 
The output turned ON/OFF by an instruction is used by presetting with an instruction such as 
the SET/RET instructions. The instruction (F165) which enables the cam output up to 32 
points to be acquired according to the elapsed value. 

• Channels and inputs to be used are specified by system registers. The output when the 
values match is specified by the operand of the instruction. 

 

10.1.2 Counting Range and Elapsed Value (Current Value) Area 

• The elapsed value of the high-speed counter is stored in a special data register as 2-word 
32-bit data. 

• The elapsed value area will be reset when the power supply turns off. It will be held when 
switching the mode from RUN to PROG. 

• The high-speed counter is a ring counter. When the counted value exceeds the maximum 
value, it returns to the minimum value. When the counted value exceeds the minimum value, 
it returns to the maximum value. 

 Counting range of elapsed value (current value) area 
Section Range 

 

High-speed 
counter control K–2,147,483,648 to K2,147,483,647 
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10.1.3 Areas Used For High-speed Counter Function 

The usable combinations vary according to the unit type. 

 List of used areas 

Channel no. 
Input no. 

Control flag Elapsed value 
area Target value area 

Single-
phase 

2-phase 

CH0 X0 X0, X1 R9110 DT90300 
DT90301 

DT90302 
DT90303 

CH1 X1 - R9111 DT90302 
DT90303 

DT90306 
DT90307 

CH2 X3 X3, X4 R9112 DT90308 
DT90309 

DT90310 
DT90311 

CH3 X4 - R9113 DT90312 
DT90313 

DT90314 
DT90315 

(Note 1): Functions, channel numbers and I/O numbers used are set in the tool software. 
(Note 2): I/O numbers used for each function should be allocated so that they do not overlap. Refer to 

"1.2Restrictions on Combinations and Functions". 
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10.1.4 Input Mode Type 

 Input Modes and Count Operations 
Mode Range 

Addition input 

 

Subtraction input 

 

2-phase input 

 

Individual input 

 

Direction 
distinction input 
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10.1.5 Minimum Input Pulse Width 

For the period T, the following minimum input pulse width is required. 

 Min. input pulse width 
Single-phase input 2-phase input 
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10.2 System Register Settings 

10.2.1 System Register Settings 

Functions to be used are allocated in the system register settings dialog box. The following 
procedure is explained on the condition that the FPWIN GR7 has already started. 

PROCEDURE  
1. Select “Option” > “System register settings” from the menu bar. 

The "PLC Configuration" dialog box appears. 

2. Select "Controller input setting (HSC/PLS)" from the left pane. 

The menu for setting "System register no. 400 or 401" appears. 

3. Change the settings for the channels used for the high-speed counter. 

The following figure shows the case when 2-phase input (X0, X1) is allocated to 
CH0. 

 
4. Press the [OK] button. 

The screen returns to the ladder edit screen. The settings will be downloaded to 
the PLC together with programs and comments. 
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 System register relating to high-speed counter output 
Classification No. and setting item Settings 

Controller input settings 
(HSC/PLS) 

400 
HSC   
operation mode 
setting  
(X0 to X2) 

CH0  

Not Set X0 as High Speed Counter 
2-phase input (X0, X1) 
2-phase input (X0, X1), Reset input (X2) 
Addition input (X0) 
Addition input (X0), Reset input (X2) 
Subtraction input (X0) 
Subtraction input (X0), Reset input (X2) 
Individual input (X0, X1) 
Individual input (X0, X1), Reset input (X2) 
Direction distinction (X0, X1) 
Direction distinction (X0, X1), Reset input (X2) 
J point positioning start input of pulse output CH0 (X0) 

CH1  

Not Set X1 as High Speed Counter 
Addition input (X1) 
Addition input (X1), Reset input (X2) 
Subtraction input (X1) 
Subtraction input (X1), Reset input (X2) 
J point positioning start input of pulse output CH1 (X1) 

401 
HSC 
operation mode 
setting  
(X3 to X5) 

CH2 

Not Set X3 as High Speed Counter 
2-phase input (X3, X4) 
2-phase input (X3, X4), Reset input (X5) 
Addition input (X3) 
Addition input (X3), Reset input (X5) 
Subtraction input (X3) 
Subtraction input (X3), Reset input (X5) 
Individual input (X3, X4) 
Individual input (X3, X4), Reset input (X5) 
Direction distinction (X3, X4) 
Direction distinction (X3, X4), Reset input (X5) 
J point positioning start input of pulse output CH2 (X3) 

CH3 

Not Set X4 as High Speed Counter 
Addition input (X4) 
Addition input (X4), Reset input (X5) 
Subtraction input (X4) 
Subtraction input (X4), Reset input (X5) 
J point positioning start input of pulse output CH3 (X4) 

(Note 1): Displayed item names and ranges vary according to the types of control unit. 
(Note 2): Select "Not set XX as High Speed Counter" for the input that is not used for the high-speed counter function. 
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10.3 High-speed Counter Instruction 

10.3.1 [F0 MV] High-speed Counter Control Instruction 

Performs the controls such as the software reset, disabling the count and clearing the high-
speed counter instruction. 

 Instruction format 

R0
DT90052H1F0 MV

DT90052H0F0 MV

S

（ ）DF

 

 Operand 
Operand Settings 

S Area storing the control code of the high-speed counter or constant data 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S A A A A A A A A A A A A 

 Outline of operation 
• Performs the high-speed counter control according to the control code specified by [S]. 

• This instruction is used when performing the following operations with the high-speed 
counter.  
(1) When performing the software reset, (2) when disabling the count, (3) when disabling the 
reset input by an external input temporarily, (4) when canceling the control executed by the 
high-speed counter instruction F165 (CAM0)/F166 (HC1S)/F167 (HC1R), when clearing the 
target value match interrupt 

• The control codes once written are held until the next writing. 

• The control code written by the F0(MV) instruction is written to the special data register 
DT90052. At the same time, it is written to the control code monitor area. The written data is 
the data for lower 8 bits only. 

 Precautions during programming 
• The setting of disabling the rest input is valid only when allocating the reset input in the 

system register. 

• In the external reset input setting, the reset input (X2 or X5) allocated to the internal input is 
switched between enable and disable. 
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 Allocation of control codes 
• The following bits are allocated according to the specified channel and functions. 

bit no.15 0
0 0 0 0 0 0 0 0

8 7

H00: Fixed

External reset input 0: Valid, 1: Invalid

High-speed counter 
instruction 0: Continue, 1: Cancel

Channel specification
H0 to H3: CH0 to CH3

Software reset 0: Disable, 1: Enable

Count 0: Enable   1: Disable

 

• When controlling the above functions using external inputs, arbitrary inputs can be allocated. 

 Example of program 
The following example shows the program for performing the software reset of the high-speed 
counter CH0 using the input X7. 

X7
DT90052H1F0 MV

DT90052H0F0 MV

（ ）DF
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10.3.2 [F1 DMV] Elapsed Value Write / Read Instruction 

Writes and reads the elapsed value of the high-speed counter. 

 Instruction format 

R0
DT90300K3000F1 DMV

DT100DT90300F1 DMV

S
（ ）DF

R1
（ ）DF

D  

 Operand 
Operand Settings 

S When setting: Area storing the elapsed value (32-bit) set in the high-speed counter or constant data  
K−2,147,483,648 to K2,147,483,647 

D When reading: Area reading the elapsed value of the high-speed counter 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S A A A A A A A A A A A A 
D - A A A A A A A A - - A 

 Outline of operation (Reading elapsed value) 
• Reads the content of the special data register storing the elapsed value of the high-speed 

counter and writes to the area specified by [D]. 

 Outline of operation (Setting elapsed value) 
• At the same time as writing the value to the elapsed value area of the high-speed counter 

which uses 32-bit data specified by [S], sets it in the elapsed value area of the high-speed 
counter used within the system. 

 Precautions during programming 
• Only F1 (DMV) instruction can perform the writing. The writing cannot be performed by other 

high-level instructions such as transfer instruction F0 (MV) and arithmetic instructions. 

• Specify the memory area of [S] or [D] with the memory area number for the lower 16 bits. 
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10.3.3 [F166 HC1S] High-speed Counter Target Value Match ON Instruction  
[F167 HC1R] High-speed Counter Target Value Match OFF Instruction 

Turns on or off the specified output when the elapsed value of the high-speed counter 
matches the target value set by the operand. 

 Instruction format 

R0
K10000H0F166 HC1S Y2

n
（ ）DF

DS

 

 Operand 
Operand Settings 

n Target channel number of the high-speed counter for the match output 

S Target value data of the high-speed counter or the starting number of the area storing data 

D Output coil which turns on or off when the values match (Y0 to Y1F) 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
n - - - - - - - - - A A - 
S A A A A A A A A A A A A 
D - - - - - - - - - - - - 

 Outline of operation 
• Sets the value specified by [S] as the target value of the high-speed counter, and controls 

the specified output [Yn] when the elapsed value matches the target value. This operation is 
executed as an interrupt processing. 

• In the case of [F166 HC1S] instruction, the output turns on from off. In the case of [F167 
HC1R] instruction, the output turns off from on. 

• Stores the value of [S] in the target value area when the instruction is executed. 

• Clears the setting of the target value and the control of the target value match output when 
the value matches the target value. 

• For resetting the output turned ON/OFF when the values match, use the RST instruction or 
F0 (MV) instruction, or use the F166 (HC1R) instruction and F167 (HC1R) instruction in a 
pair. 
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 Example of program 
The following example shows the program for setting the output Y0 when the elapsed value of 
the high-speed counter CH0 matches K10000. 

R0
K10000H0F166 HC1S Y0（ ）DF

 

 

 Precautions during programming 
• The high-speed counter control flag (R9110 to R9113) turns on until the value matches the 

target value after the execution condition of the instruction has turned on. During this 
processing, the high-speed counter instruction F165 (CAM0)/F166 (HC1S)/F167 (HC1R) 
cannot be executed for the high-speed counter of the same channel. 

• When the hardware reset is performed before the elapsed value matches the target value, 
the elapsed value will be reset. However, the settings of the target value and the target value 
match output will not be cleared.  

• For the output Y specified for the target value match output, it is not checked whether the 
output is overlapped with the OT, KP and other high-level instructions. 

• When describing the same channel in both the normal program and the interrupt program, 
be sure to program not to execute them simultaneously. 
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10.3.4 Sample Program (Positioning Operation With Inverter: First Speed) 

Counts the feedback signals from the encoder with the high-speed counter. The operation of 
the inverter stops when the count value reaches 5000. 

 Wiring example 

 

 Operation chart 

 

 I/O allocation table 
I/O no. Description I/O no. Description 

X0 Encoder input R100 Positioning operation is running. 

X5 Operation start signal R101 Positioning operation start. 

Y0 Inverter operation signal R102 Positioning done pulse 

  R9110 High-speed counter CH0 control flag 
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 Sample program 

R101
DT90300K0F1 DMV

K5000K0F167 HC1R Y0

R100
（ ）DF

R101

X5
（ ）DF

R100

R100

R9110 R102

R101 Y0
< >SET

R9110
（ ）DF/

R102

R102

R100 T0

K5TMX 0

1

2

3

4

5

6

7

 

① Positioning operation is running. 

② Positioning operation starts. 

③ Resets the elapsed value of the high-speed counter CH0. 

④ Target value match OFF instruction: Y0 turns off when the elapsed value of the high-speed counter 
reaches 5000 pulses. 

⑤ Sets the inverter operation signal Y0. 

⑥ Positioning done pulse (0.5 sec) 

⑦ Sets 0.5 sec with 0.1-second timer. 
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10.3.5 Sample Program (Positioning Operation With Inverter: Second Speed) 

Counts the feedback signals from the encoder with the high-speed counter. Switches the 
inverter operation to low speed operation when the count value reaches 4500. The operation 
of the inverter stops when the count value reaches 5000. 

 Wiring example 

 

 Operation chart 

 

 I/O allocation table 
I/O no. Description I/O no. Description 

X0 Encoder input R100 Positioning operation is running. 

X5 Operation start signal R101 Arrival at deceleration point 

Y0 Inverter operation signal R102 Positioning operation starts. 

Y1 Inverter high-speed signal R103 Positioning done pulse 

  R900C Comparison instruction < Flag 

  R9110 High-speed counter CH0 control flag 
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 Sample program 

R101
DT90300K0F1 DMV

K5000K0F167 HC1R Y0

R100
（ ）DF

R101

X5
（ ）DF

R100

R100

R9110 R103

R101 Y0
< >SET

R9110
（ ）DF/

R103

R103

R100 T0

K5TMX 0

1

2

3

4

5

10

11

Y1
< >SET 6

R100
DT90300K4500F61 DCMP 7

R100 R102
8

R900C

R102
（ ）DF

Y1
9< >RST

 

① Positioning operation is running. 

② Positioning operation starts. 

③ Resets the elapsed value of the high-speed counter CH0. 

④ Target value match OFF instruction: Y0 turns off when the elapsed value of the high-speed counter 
CH0 reaches 5000 pulses. 

⑤ Sets Y0 (inverter operation signal). 

⑥ Sets Y1 (inverter high-speed signal). 

⑦ 32-bit data comparison instruction: R900C turns on when the elapsed value of the high-speed counter 
CH0 is larger than 4500 pulses. 

⑧ Arrival at deceleration point 

⑨ Resets Y1 (inverter high-speed signal). 

⑩ Positioning done pulse (0.5 sec) 

⑪ 0.1-second timer: Sets K5. It is used as 0.5-second timer. 
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10.4 High-speed Counter Cam Control Instruction 

10.4.1  [F165 CAM0] High-speed Counter Cam Control Instruction 

Performs the cam output up to a maximum of 32 points (ON/OFF) according to the elapsed 
value of the high-speed counter. 

 Instruction format 
R0

（ ）DF

S
F165 CAM0     DT100

 

 Operand 
Operand Settings 

S Starting number of data table 

 Memory area type that can be specified 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S - - - - - - A - - - - A 

 Outline of operation 
• Performs the cam output up to a maximum of 32 points (ON/OFF) according to the elapsed 

value of the high-speed counter in the pattern specified for the data table starting with [S]. 
The output device can be selected from internal relay, output relay and link relay. 

• The ON set value and OFF set value can be arbitrarily specified as a paired target values for 
a single cam output regardless of the magnitude of target values or the order for one cam 
output. The pattern of ON/OFF varies according to the setting. 

12000
9000
7000
5000

t

y

R0

R9110

R100

R101

INT0

X2
DT90052

(bit0)

1000
0

 

Elapsed 
value

12000   0

1000 to 4999
R100:ON

7000 to 8999
R101:ON

Target value 1
ON set value
1000

Target value 2
OFF set value

9000

Target value 2 
ON set value

7000

Target value 1
OFF set value
5000  
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 Upper limit control 
With the F165 (CAM0) instruction, the control with a specified upper limit can be performed. 
The settings for enabling/disabling the upper limit control and the upper limit are specified in 
the data table. 

 Upper limit control: Enable Upper limit control: Disable 

Counting range 0 to Upper limit Negative min. value to Positive max. 
value 

Operation 
when 
exceeding 
the counting 
range 

When 
added 

When the elapsed value exceeds the 
upper limit, it returns to 0. 

When the elapsed value exceeds the 
positive maximum value, it returns to 
the negative minimum value. 

When 
subtracted 

When the elapsed value falls below 0, 
it returns to the upper limit. 

When the elapsed value falls below 
the negative minimum value, it returns 
to the positive maximum value. 

 Data table settings 
Operand Settings Description 

S, S+1 
High-speed counter channel 
Upper and lower limit control 

Specify the high-speed counter channel where the cam 
control is performed and whether or not to execute the 
upper and lower limit control as a hexadecimal constant. 

H

Channel specification

0 0 0 0 0 0

H0 to H3: CH0 to CH3

H00: Fixed

Upper limit control 0: Disable , 1: Enable

H0000: Fixed

 

S+2, S+3 Output device type (Note 1) 
Specify the device type set for the cam output.  
H0: Link relay (L), H1: Internal relay (R), H2: Output relay 
(Y) 

S+4, S+5 Starting word no. of output 
device 

Specify the starting word number of the device set for the 
cam output. (Note 2) 

S+6, S+7 No. of target values Settable range: K1 to K32 (Note 2) 
S+8, S+9 Target value 1: ON set value 

Set the ON set value and OFF set value according to the 
number of target values.  
(Note 3) 
Settable range:  
K-2147483647 to K2147483646 (H80000001 to 
H7FFFFFFE) 
The cam output described in the next page is acquired 
according to the magnitude of the ON set values and 
elapsed value. 

S+10, S+11 Target value 1: OFF set value 
S+12, S+13 Target value 2: ON set value 
S+14, S+15 Target value 2: OFF set value 
------ ------ 
S+(m-1)x4+8 
S+(m-1)x4+9 Target value m: ON set value 

S+(m-1)x4+10 
S+(m-1)x4+11 Target value m: OFF set value 

S+(m-1)x4+12 
S+(m-1)x4+13 Upper limit (Note 4) Settable range:  

K1 to K2147483646 (H1 to H7FFFFFFE) 
(Note 1): When specifying the output relay (Y), values are also output to the CPU output as well as operation 

memories. 
(Note 2): When the number of target values [S+6, S+7] is set to 1-16, the cam output is allocated to one word of 

output device. When set to 17-32, it is allocated to two words of output device. Refer to the next page for 
details. 

(Note 3): The number of target values specified after [S+8, S+9] varies according to the number of target values 
specified in [S+6, S+7]. 

(Note 4): The upper limit of the data table end is valid only when the upper limit control is set to "Yes" in [S, S+1]. This 
setting can be omitted when the upper limit control is set to "No". 

(Note 5): The data table varies in the range of 12 to 138 words according to the number of target values and the 
specified upper limit setting. 
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 Specification of output device: [S+2] to [S+5] 
• When the number of target values is set to 1-16, one word is used. When the number of 

target values is set to 17-32, two words are used. 

• One device is allocated to a paired target values (ON set value and OFF set value). 

(Example): When the output device type is set to "Internal relay", the starting word number of 
output device is set to "0", and the number of target values is set to "32", R0 to R1F are 
allocated as the device for the cam output. 

 

① When the elapsed value reaches the target value 1, R0 turns on or off. 

② When the elapsed value reaches the target value 16, RF turns on or off. 

③ When the elapsed value reaches the target value 18, R11 turns on or off. 

 Specification of target values: From [S+8] 
The acquired output varies according to the ON set value and OFF set value. 

 ON set value < OFF set 
value 

ON set value > OFF set 
value 

ON set value = OFF set 
value 

When 
added 

   

When 
subtracted 

   

Description 

When the elapsed value is 
larger than or equal to the ON 
set value and smaller than the 
OFF set value, the 
corresponding output bit turns 
on. When the elapsed value is 
out of the range, the 
corresponding bit turns off. 

When the elapsed value is 
smaller than the ON set value 
and larger than or equal to the 
OFF set value, the 
corresponding output bit turns 
off. When the elapsed value is 
out of the range, the 
corresponding bit turns on. 

When the elapsed value is out 
of the range, the 
corresponding bit turns off. 
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 Programming cautions 
• This instruction cannot be used when the high-speed counter function is not used. Allocate 

arbitrary channels and contacts in the system register "high-speed counter setting". 

• The high-speed counter control flag (R9110 to R9113) corresponding to the specified 
channel turns on until the execution of the high-speed counter control instruction F0 (MV) is 
cleared after the execution condition of the F165 (CAM0) instruction has turned on. When 
the high-speed counter control flag (R9110 to R9113) is on, the high-speed counter control 
instruction F165 (CAM0)/F166 (HC1S)/F167 (HC1R) for which the same channel is specified 
cannot be executed. 

• This instruction can be activated for up to two channels simultaneously. 

• To stop the control of this instruction, execute "Clear high-speed counter instruction" by the 
high-speed counter control instruction F0 (MV). Even when executing "Clear high-speed 
counter instruction", the output allocated to the cam output is held. Also, the counting of the 
high-speed counter continues and the upper limit control becomes disabled. 

• Reset or preset the high-speed counter elapsed value before activating the instruction. 

• Do not rewrite the elapsed value for the control using the F1 (DMV) instruction after the 
execution of the instruction.  After the execution of the instruction, the setting of the active 
target values do not change even if the operation memory of the specified target values (ON 
set value/OFF set value) is changed. 

• When controlling the output device using the main program, set each target value so that 
"minimum moving time between each target value" is larger than "1 scan time". 

• When controlling the output device using an interrupt program, set each target value so that 
"minimum moving time between each target value" is larger than "maximum execution time 
of interrupt program". 

• When the maximum value control and the hardware/software reset is used at the same time, 
do not operate them intensively in a short time. 

• When hardware/software reset is used, set the minimum target value to an integer value that 
is 1 or more. 

• When the hardware reset or software reset is executed during the high-speed counter 
control, the high-speed counter elapsed value is reset to 0. The output allocated to the cam 
output will be the output according to the elapsed value 0. 

• It is also possible to start the interrupt program INTn every time the elapsed value reaches 
each target value. For this operation, the activation of the interrupt program should be 
permitted by the interrupt control instruction ICTL. 
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10.4.2 Sample Program (Upper Limit Control, Reset, Addition) 

The following shows the program for performing two cam outputs (R100, R101) according to 
the elapsed value of the high-speed counter CH0. When the elapsed value reaches the target 
value (ON set value), the cam output turns on, and when it reaches the target value (OFF set 
value), it turns off. When it reaches the target value (ON set value), the interrupt program is 
started. When the elapsed value exceeds the upper limit, it returns to 0. 

 

Code Value Description 

ⓐ Upper limit When the elapsed value exceeds the upper limit, it returns to 0. 

ⓑ Target value 2: OFF 
set value The cam output is performed according to the target values.  

In this example, the ON set value is smaller than the OFF set value for each 
target value. Therefore, 
When added: When the elapsed value reaches the ON set value, the cam 
output turns on, and when it reaches the OFF set value, it turns off.  
When subtracted: When the elapsed value falls below the OFF set value, the 
cam output turns on, and when it falls below the ON set value, it turns off. 

ⓒ Target value 2: ON 
set value 

ⓓ Target value 1: OFF 
set value 

ⓔ Target value 1: ON 
set value 

① Execution condition When the execution condition turns on from off, the instruction is executed 
and the cam control starts.  

② High-speed counter 
instruction active flag 

The high-speed counter instruction active flag turns ON during the execution 
of the instruction. Even when the reset signal exists, the execution of the 
instruction continues. 

③ Cam output The output turns ON/OFF according the set values. 

④ Interrupt When the elapsed value reaches the ON set value, the interrupt program 
starts. 

⑤ Reset signal 

When the hardware reset (X2) or software reset DT90052 (bit 0) turns on, the 
elapsed value of the high-speed counter is rest to 0. The outputs 
corresponding to the elapsed value 0 (both R100 and R101 in the above 
example) become off. 

(Note 1): It shows the hardware reset input (X2) for the high-speed counter CH0. 
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 Sample program 

R0
（ ）DF

R9013

F165 CAM0 DT100

H10 DT100F1 DMV

K1 DT102F1 DMV

K10 DT104F1 DMV

K2 DT106F1 DMV

K1000 DT108F1 DMV

K5000 DT110F1 DMV

K7000 DT112F1 DMV

K9000 DT114F1 DMV

K11000 DT116F1 DMV

K0 DT90300F1 DMV

①
②

④
③

⑥
⑤

⑧
⑦

⑩
⑨

⑪
R9110

 

Code Description 

① High-speed counter channel H10: Performs the upper limit control. CH0 

② Cam output device type K1: Internal relay (R) 

③ Word number of cam output device K10 

④ Specification of the number of target values K2 

⑤ Target value 1: ON set value K1000 

⑥ Target value 1: OFF set value K5000 

⑦ Target value 2: ON set value K7000 

⑧ Target value 2: OFF set value K9000 

⑨ Upper limit value K11000 

⑩ Presets 0 as the elapsed value. 

⑪ Executes the F165 (CAM0) instruction and starts the cam control. 

 



 High-speed Counter Function 

10-24 
 

10.4.3 Sample Program (Upper Limit Control, Instruction Clear, Addition) 

The following shows the program for performing two cam outputs (R100, R101) according to 
the elapsed value of the high-speed counter CH0. In the case of addition, when the elapsed 
value reaches the target value (ON set value), the cam output turns on, and when it reaches 
the target value (OFF set value), it turns off. When it reaches the target value (ON set value), 
the interrupt program is started. When the elapsed value exceeds the upper limit, it returns to 
0. The instruction is cleared by the high-speed counter control instruction F0 (MV). 

 

Code Value Description 

ⓐ Positive maximum 
value 

When the instruction clear is executed, the upper limit control is canceled and 
the counting continues up to the positive maximum value. 

ⓑ Upper limit When the elapsed value exceeds the upper limit, it returns to 0. 

ⓒ Target value 2: OFF 
set value The cam output is performed according to the target values.  

In this example, the ON set value is smaller than the OFF set value for each 
target value. Therefore, 
When added: When the elapsed value reaches the ON set value, the cam 
output turns on, and when it reaches the OFF set value, it turns off.  
When subtracted: When the elapsed value falls below the OFF set value, the 
cam output turns on, and when it falls below the ON set value, it turns off. 

ⓓ Target value 2: ON 
set value 

ⓔ Target value 1: OFF 
set value 

ⓕ Target value 1: ON 
set value 

① Execution condition When the execution condition turns on from off, the instruction is executed 
and the cam control starts. 

② High-speed counter 
instruction active flag 

The high-speed counter instruction active flag turns on during the execution of 
the instruction. When the high-speed counter control instruction F0 (MV) is 
executed, it turns off. 

③ Cam output The output turns ON/OFF according the set values. 

④ Interrupt In the case of addition, when the elapsed value reaches the ON set value, the 
interrupt program is started. 

⑤ Clear high-speed 
counter instruction 

By the high-speed counter control instruction F0 (MV), when the bit 3 of the 
special data register DT90052 turns on from off, the executed F165 (CAM0) 
instruction is cleared. 
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 Sample program 
R9013

R0
（ ）DF F165 CAM0 DT100

H10 DT100F1 DMV

K1 DT102F1 DMV

K10 DT104F1 DMV

K2 DT106F1 DMV

K1000 DT108F1 DMV

K5000 DT110F1 DMV

K7000 DT112F1 DMV

K9000 DT114F1 DMV

K11000 DT116F1 DMV

K0 DT90300F1 DMV

R1
（ ）DF H8 DT90052F0 DMV

H0 DT90052F0 DMV

R9110

①
②

④
③

⑥
⑤

⑧
⑦

⑩
⑨

⑪

⑫

⑬  

Code Description 

① High-speed counter channel H10: Performs the upper limit control. CH0 

② Cam output device type K1: Internal relay (R) 

③ Word number of cam output device K10 

④ Specification of the number of target values K2 

⑤ Target value 1: ON set value K1000 

⑥ Target value 1: OFF set value K5000 

⑦ Target value 2: ON set value K7000 

⑧ Target value 2: OFF set value K9000 

⑨ Upper limit value K11000 

⑩ Presets 0 as the elapsed value. 

⑪ Executes the F165 (CAM0) instruction and starts the cam control. 

⑫ Clears the executed F165 (CAM0) instruction by turning the DT90052 (bit 3) off -> on -> off. 
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10.4.4 Sample Program (Upper Limit Control, Subtraction) 

The following shows the program for performing three cam outputs (R100-R102) according to 
the elapsed value of the high-speed counter CH0. In the case of subtraction, when the 
elapsed value falls below the target value (OFF set value), the cam output turns off, and when 
it falls below the target value (ON set value, the cam output turns on. When it falls below the 
target value (OFF set value), the interrupt program is started. When the elapsed value falls 
below 0, it returns to the upper limit. 

 

Code Value Description 

ⓐ Upper limit When the elapsed value falls below 0, it returns to the upper limit. 

ⓑ Elapsed value The control is started from the elapsed value when executed. In this example, 
the elapsed value 13000 is preset. 

ⓒ Target value 3: OFF 
set value 

The cam output is performed according to the target values.  
In this example, the ON set value is smaller than the OFF set value for any 
target values. Therefore,   
When subtracted: When the elapsed value falls below the OFF set value, the 
cam output turns on, and when it falls below the ON set value, it turns off.  
When added: When the elapsed value reaches the ON set value, the cam 
output turns on, and when it reaches the OFF set value, it turns off. 

ⓓ Target value 2: OFF 
set value 

ⓔ Target value 1: OFF 
set value 

ⓕ Target value 3: ON 
set value 

ⓖ Target value 2: ON 
set value 

ⓗ Target value 1: ON 
set value 

① Execution condition When the execution condition turns on from off, the instruction is executed 
and the cam control starts. 

② High-speed counter 
instruction active flag 

The high-speed counter instruction active flag turns on during the execution of 
the instruction. 

③ Cam output The output turns ON/OFF according the set values. 

④ Interrupt program 
activation 

In the case of subtraction, when the elapsed value falls below the OFF set 
value, the interrupt program is started. 
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 Sample program 
R9013

R0
（ ）DF F165 CAM0 DT100

H10 DT100F1 DMV ①
②

④
③

⑥
⑤

⑧
⑦

⑩
⑨

⑪

K1 DT102F1 DMV

K10 DT104F1 DMV

K3 DT106F1 DMV

K1000 DT108F1 DMV

K7000 DT110F1 DMV

K3000 DT112F1 DMV

K9000 DT114F1 DMV

K5000 DT116F1 DMV

K11000 DT118F1 DMV

K15000 DT120F1 DMV

K13000 DT90300F1 DMV ⑫

⑬
R9110

 

Code Description 

① High-speed counter channel H10: Performs the upper limit control. CH0 

② Cam output device type K1: Internal relay (R) 

③ Word number of cam output device K10 

④ Specification of the number of target values K3 

⑤ Target value 1: ON set value K1000 

⑥ Target value 1: OFF set value K7000 

⑦ Target value 2: ON set value K3000 

⑧ Target value 2: OFF set value K9000 

⑨ Target value 3: ON set value K5000 

⑩ Target value 3: OFF set value K11000 

⑪ Upper limit value K15000 

⑫ Presets 13000 as the elapsed value. 

⑬ Executes the F165 (CAM0) instruction and starts the cam control. 
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10.5 Interrupt Program Activation 

10.5.1 Overview of Function 

When the elapsed value reaches the target value while the high-speed counter instruction 
F165 (CAM0)/F166 (HC1S)/F167 (HC1R) is being executed, the interrupt program can be 
activated.  

 Execution method 
• Make the setting for the high-speed counter by system registers. There is no need to make 

the setting of interrupt input. 

• Describe the interrupt program as a sub program. 

• Allow the execution of a corresponding interrupt program number by the ICTL instruction in 
the main program. 

•  Execute the F165 (CAM0)/F166 (HC1S)/F167 (HC1R) instruction. When the elapsed value 
of the high-speed counter reaches the target value, the interrupt program is activated.  

(      ED     )
( INT     0  )

(    IRET    )
INT0 Program

F166 HC1S instruction
Target value match ON
R9110: CH0 control flag
K0: CH0 specified
K10000: Target value
Y2: Match output set

ICTL instruction
INT0 program
execution enabled

R0
H0ICTL H1

R1
K10000K0F166 HC1S Y2（ ）DF

R9110

 

 Corresponding channel numbers and interrupt program numbers 
Channel No. INT number 

CH0 INT0 
CH1 INT1 
CH2 INT3 
CH3 INT4 
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10.5.2 Interrupt Activation When F165 (CAM0) is Executed 

For the cam control instruction F165 (CAM0), the start condition varies according to the 
magnitude of the ON set value and OFF set value. Also, the interrupt program is activated 
with each target value of up to 32 points. 

 Activation of interrupt program 

 ON set value < OFF set 
value 

ON set value > OFF set 
value 

ON set value = OFF set 
value 

When 
added 

   

When 
subtracted 

   

Description 

When the elapsed value is 
larger than or equal to the ON 
set value and smaller than the 
OFF set value, the interrupt 
program is activated. 

When the elapsed value is 
smaller than the ON set value 
and larger than or equal to the 
OFF set value, the interrupt 
program is activated. 

When the elapsed value 
reaches the ON set value (= 
OFF set value), the interrupt 
program is activated. 
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11.1 Specifications 

11.1.1 General Specifications 

For details of the general specifications, refer to FP0H Users Manual (Basic). 

11.1.2 Performance Specifications 

 High-speed counter/Pulse output/PWM output specifications 

Item 
Specifications 

Type with Ethernet function Type without Ethernet function 
C32ET/C32EP C32T/C32P 

High-speed 
counter 

Controller 
input 

Single-phase 4 channels or 2-phase 2 channels  
Single-phase: Max. 100 kHz  
2-phase: Max. 50 kHz 

Pulse output CPU output 4 channels  
Max. 100 kHz 

PWM output CPU output 4 channels  
Max. 100 kHz 

(Note) For details of combinations, refer to "1.2 Restrictions on Combinations and Functions". 
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 Pulse output function (Table setting mode) specifications 
Item Specifications 

Number of axes controlled Max. 4 axes 

Common 
specifications 

Position setting mode Increment, Absolute 

Output interface Transistor open collector output 

Pulse output method Pulse＋Sign, CW+CCW 

Max. output frequency 100,000Hz 

Output pulse duty ratio When using table setting mode: 25% (Fixed) 

Control unit Pulse 

Position 
control 

Position setting range -1,073,741,824 to 1,073,741,823 pulses 
For the interpolation control, -8,388,608 to +8,388,607 pulses 

Speed reference range Pulse: 1 to 100,000 Hz 

Max. operation speed 100kHz 

Acceleration/deceleration 
method Linear acceleration/deceleration 

Acceleration time 1 to 10,000 ms (Settable by 1 ms) 

Deceleration time 1 to 10,000 ms (Settable by 1 ms) 

No. of positioning tables 20 tables for each axis 

Control 
method 

Single axis PTP control (E-point control, C-point control), CP control (P-point 
control), JOG positioning control (J-point control) (Note 1) 

2-axis linear 
interpolation 

E-, P-, C-point control; composite speed or long axis speed 
specification 

Dwell time 0 to 32,767 ms (Settable by 1 ms) 

JOG 
operation 

Speed reference range Pulse: 1 to 100,000 Hz (Note 2) 

Acceleration/deceleration 
method Linear acceleration/deceleration 

Acceleration time 0 to 10,000 ms (Settable by 1 ms) 

Deceleration time 0 to 10,000 ms (Settable by 1 ms) 

Home return 

Speed reference range Pulse: 1 to 100,000 Hz 

Acceleration/deceleration 
method Linear acceleration/deceleration 

Acceleration time 1 to 10,000 ms (Settable by 1 ms) 

Deceleration time 1 to 10,000 ms (Settable by 1 ms) 

Return method DOG methods (3 types), Home position method, Data set method 

Stop function 

Deceleration stop Each axis stops in the deceleration time of a running operation. 

Emergency stop Each axis stops in the deceleration time specified in the positioning 
parameter. 

Limit stop Each axis stops in the deceleration time specified for the limit input. 

System stop All axes stop. 

Memory backup Positioning parameters and positioning table data are stored in F-
ROM (without battery). 

(Note 1): When performing the J-point control or JOG operation, the speed can be changed after the startup. 
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11.2 Allocation of Memory Areas 

11.2.1 When Using Pulse Output Table Setting Mode 

 Control unit 

Channel no. 

Input/output contact number used Memory area 
used 

CW or 
Pulse 
output 

CCW or 
Sign 

output 

Devia-
tion 

counter 
clear 

output 

Home 
input 

(Note1) 

Near 
home 
input  

(Note 2) 

Over 
limit 
input 

(Note 3) 

J point 
positioning 
start input 

Busy 
flag 

Elapsed 
value 
area 

Indepe-
ndent 

CH0 Y0 Y1 Y2 X2 (Y850) 
(Y860) 
(Y861) 

X0 (Y808) 

(Note 4) 
CH1 Y3 Y4 Y5 X5 (Y851) 

(Y862) 
(Y863) 

X1 (Y809) 

CH2 Y8 Y9 YA X6 (Y852) 
(Y864) 
(Y865) 

X3 (Y80A) 

CH3 YB YC YD X7 (Y853) 
(Y866) 
(Y867) 

X4 (Y80B) 

Linear 
inter-
polation 
(Note 1) 

CH0 

X-
axis Y0 Y1 Y2 X2 (Y850) 

(Y860) 
(Y861) 

－ 

(Y808) 

(Note 4) 

Y-
axis Y3 Y4 Y5 X5 (Y851) 

(Y862) 
(Y863) 

(Y809) 

CH2 

X-
axis Y8 Y9 YA X6 (Y852) 

(Y864) 
(Y865) 

(Y80A) 

Y-
axis YB YC YD X7 (Y853) 

(Y866) 
(Y867) 

(Y80B) 

(Note 1): Even when setting the linear interpolation, the interpolation operation is not performed for the home return. 
Execute the operation for X axes and Y axes separately. 

(Note 2): The near home input will be valid when arbitrary inputs are allocated and the output relays indicated in the 
above table turn ON. 

(Note 3): The over limit input (+) and over limit input (-) will be valid when arbitrary inputs are allocated and the output 
relays indicated in the above table turn ON. The I/O numbers in the upper rows (Y860 to Y866) in the above 
table are over limit input (+), the I/O numbers in the lower rows (Y861 to Y867) are over limit input (-). 

(Note 4): The elapsed values are stored in the axis information area of the positioning memory. They can be read by 
user programs using the F384 instruction. 
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11.2.2 When Using PWM Output Function 

 Control unit 
Channel no. Output no. Control flag Output frequency (Duty) 

CH0 Y0 R911C 
1.0 Hz to 70 kHz: Resolution of 1000 (0.0% to 100.0%)  
70001 Hz to 100 kHz: Resolution of 100 (0% to 100%) 

CH1 Y3 R911D 
CH2 Y8 R911E 
CH3 YB R911F 

 

 Maximum output frequency of pulse output/PWM output 
These values are available only when the conditions of each item (such as output method or 
channels) are executed. These values are available when the operations such as the high-
speed counter, pulse output function or other interrupt controls are not performed. 
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11.2.3 When Using Pulse Output Function (FPΣ Compatible Instruction Mode) 

 Control unit 

Channel no. 

Input/output contact number used Memory area used 

Max. 
output 

frequency 
(Note 4) 

Related 
instruct-

tions 
CW or 
Pulse 
output 

CCW 
or 

Sign 
output 

Devia-
tion 

counter 
clear 

output 

Home 
input 

(Note1) 

Near 
home 
input  

(Note 2) 

Execu-
tion 
flag 

Elapsed 
value 
area 

(Note 3) 

Target 
value 
area 

Correction 
speed 
area 

of initial 
speed 

Independent 

CH0 Y0 Y1 Y2 X2 

DT 
90052 
bit 4 

R911C 
DT90348 
DT90349 

DT90350 
DT90351 

DT90400 
DT90401 

100kHz 

F0 
(MV) 
F1 

(DMV) 
F171 

(SPDH) 
F172 

(PLSH) 
F174 

(SP0H) 
F175 

(SPSH) 

CH1 Y3 Y4 Y5 X5 R911D 
DT90352 
DT90353 

DT90354 
DT90355 

DT90402 
DT90403 

100kHz 

CH2 Y8 Y9 YA X6 R911E 
DT90356 
DT90357 

DT90358 
DT90359 

DT90404 
DT90405 

100kHz 

CH3 YB YC YD X7 R911F 
DT90360 
DT90361 

DT90362 
DT90363 

DT90406 
DT90407 

100kHz 

Linear interpolation 

CH0 

X-
axis Y0 Y1 Y2 X2 

- 

R911C 
DT90348 
DT90349 

DT90350 
DT90351 

DT90400 
DT90401 

Composite 
speed 

100kHz 

Y-
axis Y3 Y4 Y5 X5 R911D 

DT90352 
DT90353 

DT90354 
DT90355 

DT90402 
DT90403 

CH2 

X-
axis Y8 Y9 YA X6 R911E 

DT90356 
DT90357 

DT90358 
DT90359 

DT90404 
DT90405 

Y-
axis YB YC YD X7 R911F 

DT90360 
DT90361 

DT90362 
DT90363 

DT90406 
DT90407 

(Note 1): Even when setting the linear interpolation, the interpolation operation is not performed for the home return. 
Execute the operation for X axes and Y axes separately. 

(Note 2): The near home input will be valid when an arbitrary input is allocated and the bit 4 of the special data 
register DT90052 turns on. 

(Note 3) Only F1 (DMV) instruction can perform the reading and writing of elapsed value area. 
(Note 4): These values are available only when the conditions of each item (such as output method or No. of 

channels) are executed.  
These values are not available if executing the HSC match ON/OFF instruction, other pulse I/O process 
simultaneously or executing the interrupt program. 
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11.2.4 When Using High-speed Counter Function 

 Control unit 

Channel no. Count input 
Hardware 

reset 
input 

Memory area used Performance 
Specifications 

Control 
flag 

Elapsed 
value 
area 

Target 
value 
area 

Min. 
input 
pulse 
width 

Max. 
counting 

speed 

[Single-phase]  
Addition input  
Subtraction 
input 

CH0 X0 X2 R9110 DT90300 
DT90301 

DT90302 
DT90303 

High-
speed 
input 
5 μs 

100kHz 
CH1 X1 X2 R9111 DT90304 

DT90305 
DT90306 
DT90307 

CH2 X3 X5 R9112 DT90308 
DT90309 

DT90310 
DT90311 

CH3 X4 X5 R9113 DT90312 
DT90313 

DT90314 
DT90315 

[2-phase input]  
Phase 
difference 
input  
Individual 
input  
Direction 
distinction 

CH0 X0 
X1 X2 R9110 DT90300 

DT90301 
DT90302 
DT90303 High-

speed 
input 
10 μs 

50 kHz 

CH2 X3 
X4 X5 R9112 DT90308 

DT90309 
DT90310 
DT90311 

(Note 1): When the reset input settings of reset input for the single-phase input overlap at CH0 and CH1 or CH2 and 
CH3, the setting of CH0 or CH2 has priority. 

(Note 2) Only F1 (DMV) instruction can perform the reading and writing of elapsed value area. 
 

 Maximum counting speed 
These values are available only when the conditions of each item (such as counting method 
or channels) are executed. These values are available when the high-speed counter match 
ON (F166) instruction, high-speed counter match OFF (F167) instruction, pulse output 
function or other interrupt controls are not performed.  
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11.3 Positioning Memory 

11.3.1 Configuration of Memory Map 

The positioning memory consists of four areas. 

 Whole memory map 
Area Absolute  

(Decimal) No. of words and configuration 
No. Name 

0 Common 
area 0000-0029 30 words 

1 
Axis 
information 
area 

0030-0039 For CH0 

10 words for each channel  
0040-0049 For CH1 

0050-0059 For CH2 

0060-0069 For CH3 

0070-0099 Reserved for system 

2 Axis setting 
area 

0100-0129 For CH0 

30 words for each channel  
0130-0159 For CH1 

0160-0189 For CH2 

0190-0219 For CH3 

0220-0299 Reserved for system 

3 
Positioning 
Table 
area 

0300-0549 

For CH0 250 words for each channel 

 0300-0309 Table 1 

10 words for each table  ｜ ｜ 

 0490-0499 Table 20 

 0500-0549 Reserved area for the system 

0550-0799 For CH1 

250 words for each channel 
0800-1049 For CH2 

1050-1299 For CH3 

1300-1799 Reserved for 
system 

(Note 1): The addresses in the table are the addresses which indicate the configurations in the positioning memory. 
For reading/writing data using user programs, use an area number and offset address in combination for 
specification. 
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 Reading from positioning memory 
• It is possible to read the areas which are shown with "Available" in the "R" column in the 

following table using the F384 (PTBLR) instruction in user programs during RUN. The 
operand of the instruction is specified using the combination of an area number and offset 
address. 

 Writing to positioning memory 
• When the mode changes from PROG. to RUN, the contents set by the tool software 

Configurator PMX will be stored. 

• It is possible to rewrite the areas which are shown with "Available" in the "W" column in the 
following table using the F385 (PTBLW) instruction in user programs during RUN. The 
operand of the instruction is specified using the combination of an area number and offset 
address. 

• Be sure not to execute writing in the reserved areas for the system. 
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11.3.2 Common area (Memory Area No. 0) 

●: Available, -: Not available 
Address Name Default Description R W 

0000 Axis setting H0 

Stores used channels (axes) and usage methods.  
Monitor using binary display. 

bit no. Settings 

0 Not use CH0 (0) / Use CH0 (1) 

1 Not use CH1 (0) / Use CH1 (1) 

2 Not use CH2 (0) / Use CH2 (1) 

3 Not use CH3 (0) / Use CH3 (1) 

4-7 Disable the setting 

8 
As interpolation axis,  
Not use CH0/CH1 (0) / Use 
CH0/CH1 (1) 

9 
As interpolation axis, 
Not use CH2/CH3 (0) / Use 
CH2/CH3 

10-15 Disable the setting 
 

  

0001 Positioning repeat count 
(CH0) K0 Stores the repeat count in decimal when using the 

repeat control in the position control. 

Set value Operation 

0 or 1 Not repeat an operation. 

2-254 Repeat an operation for a 
specified number of times. 

255 or 
more Repeat an operation infinitely. 

 

  

0002 Positioning repeat count 
(CH1) K0   

0003 Positioning repeat count 
(CH2) K0   

0004 Positioning repeat count 
(CH3) K0   

0005 
-0006 Reserved for system - - - - 

0007 Error code H0 

Stores a generated positioning error code in Hex 
format (hexadecimal) when using the pulse output 
function (table setting mode). 
The higher 8 bits indicate channel number.  
The lower 8 bits indicate error code. 

 - 

0008 
-0029 

Reserved for system - - - - 

 
 



11.3 Positioning Memory 

 

 
11-11 

11.3.3 Axis Information Area (Memory Area No. 1) 

●: Available, -: Not available 
Offset 
address Name Default Description R W 

0000 Active or execution 
done table K0 

Stores the monitor values of the positioning table 
numbers during the execution or on the 
completion of each channel. 
Stored value: 0-20 

 - 

0001 Repeat count current 
value K0 

Stores the repeat count during the operation of 
each channel. The execution start time is 
counted as “1”. When the repeat count exceeds 
the upper limit, it returns to “0”. When the repeat 
operation is not enabled, “0” is stored at the 
positioning control start time. 
Stored value: 0-65535 

 - 

0002 
-0003 

Elapsed value (Current 
value coordinate) K0 

Stores the elapsed values (current value 
coordinate) of each channel. 
Range: -1,073,741,824 to 1,073,741,823 
For the interpolation control, the setting range is 
as follows.  
-8,388,608 to +8,388,607 

  

0004 
-0009 Reserved for system - - - - 



 Specifications 

11-12 
 

11.3.4 Axis Setting Area (Memory Area No. 2) 

●: Available, -: Not available 
Offset 
address Name Default Description R W 

0000 Pulse output 
control code H0 

Stores the settings of pulse output, home position, near home 
position, and limit signal of each channel. Monitor in binary 
format. 

bit 
no. 

Item Settings 

0 Output 
method 

0: Pulse/Sign 
1: CW/CCW 

1 Rotation 
direction 

0: Elapsed value + Direction is 
CW  
(Forward OFF/Reverse ON)  
1: Elapsed value + Direction is 
CCW  
(Forward ON/Reverse OFF) 

2 Home 
position logic 

0: Normal Open (A contact)  
1: Normal Close (B contact) 

3 Near home 
logic 

4 Limit (+) logic 

5 Limit (-) logic 

6-15 Disable the 
setting  

 

  

0001 
-0002 

Startup 
speed K100 

Stores the settings of the startup speed for each operation of 
each channel in decimal. 
Setting range: 1 to 100,000 

  

0003 Home return 
method HFF 

Stores the settings of home return patterns of each channel. 
H0: DOG method 1 
H1: DOG method 2 
H2: DOG method 3 
H3: Setting error 
H4:  Setting error 
H5: Home position method (Z phase method) 
H6: Data set 
HFF: Unused 

  

0004 Home return 
direction K0 

Stores the settings of home return operation direction in 
decimal. 
0: Elapsed value decreasing direction (Limit - direction)  
1: Elapsed value increasing direction (Limit + direction) 

  

0005 
Home return   
acceleration 
time 

K100 

Stores the settings of the acceleration time for the home return 
of each channel in decimal. It indicates the time from the 
startup speed to the home return target speed. 
Setting range: 1-10,000 (ms) 

  

0006 
Home return   
deceleration 
time 

K100 

Stores the settings of the deceleration time for the home return 
of each channel in decimal. It indicates the time from the home 
return target speed to the startup speed. 
Setting range: 1-10,000 (ms) 
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Offset 
address Name Default Description R W 

0007 
-0008 

Home return   
target speed K1000 

Stores the settings of the target speed for the home return of 
each channel in decimal. 
Setting range: 1 to 100,000 

  

0009 
-0010 

Home return 
creep speed K100 

Stores the settings of the creep speed for the home return of 
each channel in decimal. 
Setting range: 1 to 100,000 

  

0011 
Deviation 
counter clear 
time 

K1 

Stores the settings of the deviation counter clear signal ON 
time after the completion of home return of each channel in 
decimal. 
Setting range: 1 to 100 (ms) 
In the case of 0, no deviation counter clear signal is output.  
In the case of 100 or more, the ON time is set to 100 ms. 

  

0012 
-0013 

Coordinate 
origin K0 

Stores the elapsed values (current value) after the home 
return. 
Range: -1,073,741,824 to 1,073,741,823 
For the interpolation control, the setting range is as follows.  
-8,388,608 to +8,388,607 

  

0014 
JOG 
acceleration 
time 

K0 

Stores the settings of the acceleration time for the JOG 
operation of each channel in decimal. It indicates the 
acceleration time from startup speed to JOG operation target 
speed. 
Setting range: 0 to 10,000 (ms) 

  

0015 
JOG 
deceleration 
time 

K0 

Stores the settings of the deceleration time for the JOG 
operation of each channel in decimal. It indicates the 
deceleration time from JOG operation target speed to startup 
speed. 
Setting range: 0 to 10,000 (ms) 

  

0016 
-0017 

JOG 
operation 
target speed 

K1000 
Stores the settings of the target speed for the JOG operation 
of each channel in decimal. 
Setting range: 1 to 100,000 

  

0018 
-0019 

J point 
change 
target speed 

K1000 
Stores the settings of the target speed for changing the J-point 
control speed for each channel in decimal. 
Setting range: 1 to 100,000 

  

0020 

Emergency 
stop 
deceleration 
time 

K100 

Stores the settings of the deceleration time for the emergency 
stop operation of each channel in decimal. It indicates the 
deceleration time from 100 kHz to 0 Hz. 
Setting range: 0 to 10,000 (ms) 

  

0021 
Limit stop 
deceleration 
time 

K100 

Stores the settings of the deceleration time for the limit stop 
operation of each channel in decimal. It indicates the 
deceleration time from 100 kHz to 0 Hz. 
Setting range: 0 to 10,000 (ms) 

  

0022 
-0029 

Reserved for 
system - - - - 

(Note 1): The emergency stop deceleration time and limit stop deceleration time indicates the deceleration time in the 
section from 100 kHz to 0 Hz. When the speed during the operation is less than 100 kHz, the actual 
deceleration time is shorter than the set time. 
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11.3.5 Positioning Table Area (Memory Area No. 3) 

●: Available, -: Not available 
Offset 
address Name Default Description R W 

0000 Control code H0 

Stores the settings of the position specification method for the 
positioning operation. 

bit no. Item Settings 

0 Control method 0: Increment mode 
1: Absolute mode 

1-15 Disable the setting  
 

  

0001 Control 
pattern H0 

Stores the settings of single axis and interpolation operation 
pattern of positioning operation. In the interpolation operation, 
the setting for the axis with the smallest number in an axis group 
is effective. 

bit no.15 0
0 0 0 0 0 0 0

8 7

Channel specification
H00: Linear interpolation 

(Composite speed) 
H01: Linear interpolation 

(Long axis speed)
xControl pattern
H00: E-point control (End point control) 
H01: P-point control (Pass point control) 
H02: C-point control (Continuance point control) 
H03: J-point control (Speed point control)  

  

0002 
Positioning 
acceleration 
time 

K100 

Stores the settings of the acceleration time for the positioning 
operation. It indicates the acceleration time from the startup 
speed to the target speed.  
Setting range: 1 to 10,000 (ms) 

  

0003 
Positioning 
deceleration 
time 

K100 

Stores the settings of the deceleration time for the positioning 
operation. It indicates the deceleration time from the target 
speed to the startup speed.  
Setting range: 1 to 10,000 (ms) 

  

0004 
-0005 

Positioning 
target speed K1000 

Stores the settings of the target speed for the positioning 
operation. In the interpolation operation, the setting for the axis 
with the smallest number in an axis group is effective. 
Setting range: 1 to 100,000 

  

0006 
-0007 

Positioning 
movement 
amount 

K0 

Stores the settings of the movement amount for the positioning 
operation. 
Setting range: -1,073,741,824 to 1,073,741,823 
For the interpolation control, the setting range is as follows.  
-8,388,608 to +8,388,607 

  

0008 Dwell time K0 Stores the setting of dwell time.  
Setting range: 0 to 32,767ms   

0009 Reserved for 
system - - - - 

(Note 1): The offset addresses in the above table are for the table no. 0. They vary according to the table numbers as 
described on the next page. 



11.3 Positioning Memory 

 

 
11-15 

 Offset addresses 

Table 
no. 

Control 
code 

Control 
pattern 

Positioning 
acceleration 

time 

Positioning 
deceleration 

time 

Positioning 
target  
speed 

Positioning 
movement 

amount 
Dwell 
time 

1 0 1 2 3 4-5 6-7 8 
2 10 11 12 13 14-15 16-17 18 
3 20 21 22 23 24-25 26-27 28 
4 30 31 32 33 34-35 36-37 38 
5 40 41 42 43 44-45 46-47 48 
6 50 51 52 53 54-55 56-57 58 
7 60 61 62 63 64-65 66-67 68 
8 70 71 72 73 74-75 76-77 78 
9 80 81 82 83 84-85 86-87 88 
10 90 91 92 93 94-95 96-97 98 
11 100 101 102 103 104-105 106-107 108 
12 110 111 112 113 114-115 116-117 118 
13 120 121 122 123 124-125 126-127 128 
14 130 131 132 133 134-135 136-137 138 
15 140 141 142 143 144-145 146-147 148 
16 150 151 152 153 154-155 156-157 158 
17 160 161 162 163 164-165 166-167 168 
18 170 171 172 173 174-175 176-177 178 
19 180 181 182 183 184-185 186-187 188 
20 190 191 192 193 194-195 196-197 198 

(Note): For the positioning target speed and positioning movement amount, specify the lower address number of 2-
word area. 
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